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بدء الاستخدام   1

 برنامجًا مثالياً لتطبيقات التصوير ومعالجة النماذج وسير العمل، Kodak  Capture Proيعد برنامج 
وكتطبيق مستقل. ويعمل البرنامج على إدارة عمليات المسح الضوئي على وجه واحد وعلى وجهين، كما يساعد 
على الفهرسة وإنشاء المجموعات بالألوان و/أو الأبيض والأسود و/أو تدرج الرمادي. ويمكن تصدير الدفعات 

 إمكانية استخدام ميزات الماسحة Capture Proبسهولة إلى العديد من التطبيقات الشائعة. كما يتيح لك برنامج 
الضوئية الكاملة لتحقيق الحد الأقصى من الإنتاجية. وحيث إن جميع الوظائف يمكن تنفيذها في البرنامج؛ فلن 

تحتاج إلى استخدام مُسرع خاص للجهاز.

 بحيث يعمل بسرعة ودقة، وذلك بالإضافة إلى سهولة استخدامه. وهو Capture Proلقد تم تصميم برنامج 
يساعد الماسح الضوئي على العمل بأقصى طاقته بحيث يوفر الإنتاجية المثلى. تعرض شاشة العرض، متعددة 

 وهناك أيضًا  ، الصور وبيانات الفهرس الاختيارية أثناء مسح المستندات ضوئياً.الصفحات عالية السرعة
. مجموعة كاملة من الأدوات التي تساعد على تسهيل إدارة المسح الضوئي، ولكل أداة أيقونة خاصة بها

يوفر هذا الدليل خطوات أساسية لإنشاء مجموعة جديدة، وإجراء مسح ضوئي للمستندات، وتعديل الصور التي 
يتم مسحها ضوئياً وإخراج مجموعة. كما يقدم وصفاً للنوافذ والقوائم والأدوات.

تتوفر الوثائق التالية إضافةً إلى دليل المستخدم:وثائق الدعم

— توفر معلومات حول المنتج تتضمن إعداد المنتج وتفاصيل حول واجهة المستخدم المساعدة عبر الإنترنت •
والعديد من الميزات المتقدمة. للبحث عن معلومات في ملف المساعدة، يمكنك استخدام جدول المحتويات أو 

الفهرس أو ميزة البحث. 

 (مساعدة) من مربع حوار أو انقر على Help، ثم حدد الزر F1للوصول إلى المساعدة، اضغط على المفتاح 
الموجودة بالزاوية اليمنى العلوية في أي نافذة.؟ أيقونة 

 Capture— يعرض إجراءات سهلة لبدء تشغيل سريع يشمل تثبيت وتشغيل برنامج دليل بدء التشغيل •
Pro .ًكما يوفر أيضًا إجراءات للمسح الضوئي باستخدام عمليات إعداد المهام الافتراضية المعرّفة مسبقا .

 Capture لهذا الدليل في قسم الكتيبات والأدلة في صفحة ويب دعم برنامج PDFيمكن العثور على ملف 
Pro:من خلال الرابط 

 https://support.alarisworld.com/capture-pro-software#Manuals

— يوفر معلومات تفصيلية حول إنشاء عمليات إعداد المهام التي تسمح للمستخدمين دليل المسؤول •
. كما يتضمن أيضًا معلومات حول إعداد Capture Proبأكثر الوسائل فعالية لاستخدام برنامج 

يمكن العثور على ملف . الصفحات والرموز الشريطية ورموز المجموعة والاستيراد التلقائي وغير ذلك
PDF الدليل في قسم الكتيبات والأدلة في صفحة ويب دعم برنامج  لهذاCapture Pro :من خلال الرابط 

https://support.alarisworld.com/capture-pro-software#Manuals

 الإصدار الشبكي. يمكن Capture Pro — يوفر إجراءات التثبيت لبرنامج إصدار الشبكة: دليل النظام•
 Capture Pro لهذا الدليل في قسم الكتيبات والأدلة في صفحة ويب دعم برنامج PDFالعثور على ملف 
https://support.alarisworld.com/capture-pro-software#Manualsمن خلال الرابط: 

 — تحتوي على معلومات قد تكون غير متوفرة في وثائق الدعم الأخرى. لعرض ملاحظات حول الإصدار•
 وانتقل إلى قسم www.kodakalaris.com/go/kcsdownloadsملاحظات الإصدار، انتقل إلى 

محطة العمل/برنامج العميل في موقع ويب.

https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
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قبل أن تبدأ الاستخدام، قد تساعدك المعلومات التالية التي توفر بعض المفاهيم الأساسية حول بعض المصطلحات المصطلحات
. Capture Proالمستخدمة في برنامج 

 بأنها تكوين تم إعداده لالتقاط مجموعة من المهام إلى "المهام". ويمكن تعريف Capture Proيستند برنامج 
المستندات التي تريد مسحها ضوئياً ومعالجتها. 

 للاحتفاظ بالمستندات، والصور، والبيانات التي تم مجموعةلمسح مستندات ضوئياً في المهام، تحتاج إلى إنشاء 
مسحها ضوئياً قبل إخراجها.

 المستندات التي تم مسحها ضوئيًا بالتسلسل الهرمي التالي:Capture Proينظم برنامج 

: تحتوي على مستند واحد أو أكثر تم مسحه ضوئياً (مثل مجلد أو ملف معلق يحتوي على العديد المجموعة•
من المستندات المنفصلة).

: يحتوي على صفحة واحدة أو أكثر مرتبطة بعنصر واحد (مثل محتويات مغلف ما).المستند•

: أوراق حقيقية يتم إدخالها إلى الماسحة الضوئية لإنتاج الصور.الصفحة•

: تمثيل إلكتروني للصفحات التي تم مسحها ضوئياً.الصورة•

هي العملية التي يتم فيها إرسال المجموعة إلى نظام الإخراج / الموقع المطلوب بالتنسيق الذي تختاره.الإخراج 

 Captureتشغيل برنامج 
Pro

؛ فتأكد من تشغيل الماسحة الضوئية وتوصيلها  الاستيراد التلقائي  أوالفهرس فقطإذا كنت لا تستخدم إصدارات 
 بالكمبيوتر USBبالكمبيوتر بشكل سليم. وإذا كنت قد اشتريت مفتاح جهاز اختياري؛ فتأكد من تركيبه في منفذ 

الخاص بك. 

ملاحظات:

يقوم عملاء إصدار الشبكة بإشعارك أثناء الحصول على ترخيص.•

 بإجراء المزامنة الأولية مع برنامج Capture Pro Softwareسيقوم عملاء إصدار الشبكة لبرنامج •
Capture Pro Server Software.

 الموجودة على سطح Capture Pro Softwareانقر نقرًا مزدوجًا على أيقونة برنامج •
المكتب، أو

.Kodak Capture Pro > برنامج Kodakابدأ > البرامج > انتقل إلى: •
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لم يتم تحديد ماسحتك  لأول مرة، يتم عرض الرسالة Capture Pro Softwareعند تشغيل برنامج تحديد ماسحتك الضوئية
 (نعم) لعرض شاشة إعداد محطة العمل. يمكنك من هذه Yes. انقر على هل تريد إعدادها الآن؟الضوئية. 

الشاشة تحديد الماسحة الضوئية التي ستستخدمها من قائمة أجهزة المسح الضوئي المتوفرة. سيتم تجاوز هذه 
الخطوات عند تشغيل البرنامج في المرات التالية.

 (تحديد). سيتم عرض شاشة تحديد الماسحة الضوئية.Selectانقر على .1

 (موافق). سيتم عرض شاشة OKحدد الماسحة الضوئية التي قمت بتثبيتها على الكمبيوتر، وانقر على .2
البدء السريع.

(موافق) على شاشة إعداد محطة العمل. OKانقر على .3

 بدون Capture Pro (الاستيراد التلقائي) إذا كنت تريد استيراد الصور إلى Auto Importحدد .4
استخدام ماسحة ضوئية فعلية أو تدخل يدوي.
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توفر شاشة البدء السريع قائمة للوظائف ولوحات المهام شائعة الاستخدام.البدء السريع

تعرض صفحة لوحات المهام إعدادات المهام التي تم إنشاؤها. ويتم عرض اللوحات بالترتيب الأبجدي، ويمكن 
أن تتغير الألوان إذا تمت إضافة لوحات مهام أخرى أو حذفها.

لن تتلاءم أسماء المهام الطويلة على الزر وسيتم قطع الاسم. يؤدي تمرير المؤشر على الزر إلى ملاحظة:
عرض الاسم الكامل للمهمة. يوصى بأن تكون أول كلمات قليلة من اسم المهمة فريدة ووصفية 

ومعبرة.

 — يسمح لك بفتح مجموعات المستندات الحالية أو إنشاء مجموعات جديدة أو عرض حالة أي مدير المجموعة
مجموعات موجودة.

. يمكنك فتح أو عمل مجموعة جديدة أو Capture Pro — تعرض الشاشة الرئيسية لبرنامج القائمة الرئيسية
بدء التقاط مستند، وتعديل عمليات إعداد المهام، وتعديل المستخدمين والمجموعات، بالإضافة إلى تنفيذ العديد من 

مهام تهيئة النظام.

— يسمح هذا الخيار بتسجيل خروج المستخدم الحالي.تسجيل الخروج 

.Capture Pro — للخروج من برنامج خروج

عند النقر على لوحة المهام، يتم عمل مجموعة جديدة ويبدأ المسح كما هو محدد من خلال إعداد المهام. بعد 
إخراج والانتهاء من المهام، يتم عرض شاشة البدء السريع مرة أخرى.

ملاحظات: 

إذا كنت مستخدمًا خبيرًا أو إذا لم تكن ترغب في استخدام لوائح مهام البدء السريع؛ فيمكنك تعطيل شاشة البدء •
 (عرض البدء السريع) في مربع حوار إعداد محطة Quick Start Viewالسريع من خلال إلغاء تحديد 

 (ملف > File > Workstation Setupالعمل. للوصول إلى مربع حوار إعداد محطة العمل، حدد 
إعداد محطة العمل) من الشاشة الرئيسية. 

يمكن استخدام أيقونة "البدء السريع" الموجود في شريط الأدوات "عرض" للانتقال مرة أخرى إلى شاشة •
"البدء السريع" من "القائمة الرئيسية"

.الاستيراد التلقائيأو الفهرس فقط يتم تعطيل "البدء السريع" لإصدارات •
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، إذا لم يتم تمكين عرض البدء السريع، فسيتم عرض مربع Capture Proعند تسجيل الدخول إلى برنامج مربع حوار إدارة المجموعة
 (المجموعة Batch > Openحوار مدير المجموعة. يمكن أيضًا عرض مربع حوار إدارة المجموعة بتحديد 
> فتح). استخدم هذا المربع لإدارة كل الدفعات المقترنة بعمليات إعداد المهام.

 من أيٍ من عمليات إعداد مجموعة— يسرد هذا الخيار كل عمليات إعداد المهام لديك. حدد المهام المتوفرة 
المهام هذه.

اسم المهمة، ورقم المجموعة، ووقت الإنشاء، وحالة — يعرض هذا الخيار الحقول دفعات المهمة المحددة 
للمهام المحددة.تأمين بواسطة والمجموعة 

، الذي يسمح لك بتحديد الحالات المطلوبة مربع حوار خيارات الإظهار — يعرض هذا الخيار خيارات الإظهار
 في مربع الحوار مدير المجموعة.حالة المجموعة، وما إلى ذلك.) لعرضها في حقل  جارِ المعالجة، متوفر(مثل 

. كقيد الاستخدام— يعرض هذا الخيار المجموعة التي حددتها بالقائمة. لن يفتح الأمر فتح مجموعة مدرجة فتح 
يجب أن يكون لديك إذن القراءة/الكتابة لموقع الصورة التي تم مسحها ضوئياً حتى تتمكن من فتح مجموعة حالية.

، والذي يتيح لك إمكانية إنشاء مجموعة جديدة.مربع حوار المجموعة الجديدة — يعرض هذا الخيار جديد
، الذي يتيح لك إمكانية إعادة تسمية مربع حوار إعادة تسمية المجموعة — يعرض هذا الخيار إعادة تسمية

المجموعة المحددة.
 — يمكنك هذا الخيار من حذف المجموعة المحددة. يتم عرض مربع لتأكيد عملية الحذف.حذف

 — يمكنك هذا الخيار من إرسال المجموعة التي ستتم معالجتها. إخراج
 لتراخيص المجموعة "أ" و"ب"، يجب تركيب الماسحة الضوئية المادية لإخراج المجموعات. عند ملاحظة:

الحاجة إلى إخراج مجموعة دون تركيب الماسحة الضوئية، يمكن شراء ترخيص فهرسة في ذلك 
الوقت.

 — يمكنك هذا الخيار من إغلاق مربع الحوار.إغلاق

انقر لعرض كل الدفعات الموجودة في كل عمليات إعداد المهام.

انقر لإخفاء كل الدفعات الموجودة في كل عمليات إعداد المهام.
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إذا أردت مسح المستندات ضوئياً، يجب إنشاء مجموعة جديدة أو فتح مجموعة حالية لمسح معلومات المستندات إنشاء مجموعة جديدة
ضوئياً. في معظم الحالات، يكون مسؤول النظام قد قام بالفعل بتكوين المهام التي ستستخدمها. ويتم سرد هذه 

المهام في مربع حوار مدير المجموعة.

لإنشاء مجموعة جديدة:

. يتم عرض مربع حوار مدير المجموعة.Capture Proقم بتشغيل برنامج .1

.مربع حوار المجموعة الجديدة. سيتم عرض جديدحدد .2

. سيتم التقاط المجموعة الجديدة وإخراجها كما هو معرّف اسم المهمةحدد إعداد المهمة من القائمة المنسدلة .3
في إعداد المهمة.

 Capture Pro إذا كان ذلك ممكناً. يقترح برنامج اسم المجموعةأدخل اسم المجموعة الجديدة في الحقل .4
بشكل افتراضي اسم مجموعة جديدة استنادًا إلى اسم المجموعة الأخيرة الذي تم إنشاؤه لإعداد المهمة. على 

؛ فيكون الاسم الافتراضي للمجموعة الجديدة هو Health030سبيل المثال، إذا كان اسم آخر مجموعة هو 
Health031.

تمكين التعداد الرقمي للمجموعة الخاصة . عند تعطيل الخيار بالنسبة لعملاء إصدار الشبكةملاحظة:
 في إعداد محطة العمل وكان اسم المجموعة يتضمن بمستوى المهمة

>BATCH_COUNTER" إلى جانب اسم معين بواسطة النظام>؛ فستظهر العبارة "
المجموعة ولن تتوفر إمكانية تغييره.

معرّف مستند البداية عبارة عن معرّف يجب تعيينه لأول  ، إذا كان ذلك ممكناً.معرف مستند البدايةأدخل .5
. بشكل افتراضي، يقترح البرنامج 1مستند في المجموعة. في معظم الحالات، يكون هذا المعرّف هو الرقم 

رقمًا لمستند البداية استنادًا إلى إعداد المهمة.

 باسم المجموعة الذي قمت بتعيينه. النافذة الرئيسية على عارض الصور (موافق). سيظهر OKانقر على .6
 فارغة إلى أن يبدأ وعارض الصور المصغرّة، ومستكشف المجموعةستظل ميزات عارض الصور، 

المسح الضوئي.
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 (مجموعة جديدة) في شريط New Batchيمكنك أيضًا إنشاء مجموعة جديدة بالنقر على أيقونة .7
الأدوات.

لفتح مجموعة موجودة، قم بما يلي:فتح مجموعة موجودة

. سيتم عرض مربع حوار مدير المجموعة (المجموعة > فتح). يتم عرض Batch > Open حدد.1
المجموعات من كل عمليات إعداد المهام اعتمادًا على الإعدادات الموجودة.

 (فتح). سيتم عرض المجموعة التي حددتها في Openقم بتمييز المجموعة التي تريدها، ثم انقر على .2
. يمكنك الآن استخدام هذه المجموعة.عارض الصورمستكشف المجموعة

 (فتح مجموعة) مربع حوار مدير المجموعة.Open Batchيفتح النقر على أيقونة .3

إذا كنت تجري مسحًا ضوئياً في بيئة تتضمن العديد من أجهزة المسح الضوئية وتم فتح ملاحظة:
 Capture Pro منصة عمل أخرى؛ فلن يسمح لك برنامج التي حددتها بالفعلفي المجموعة

يتعذر فتح المجموعة نظرًا لأنها قيد الاستخدام حالياً  ، الرسالةسيتم عرضبفتح المجموعة. 
. على الشاشةبواسطة مستخدم آخر 

يقوم خيار حذف مجموعة بمسح الصور وبنية دليل المجموعة الفرعي للمجموعة المحددة.حذف مجموعة

. سيتم عرض مربع حوار مدير المجموعة (المجموعة > فتح). يتم عرض Batch > Open حدد.1
المجموعات من كل عمليات إعداد المهام اعتمادًا على الإعدادات الموجودة.

هل تريد  (حذف). سيتم عرض الرسالة Deleteقم بتمييز المجموعة التي تريد حذفها، ثم انقر على .2
."؟XXXXXبالتأكيد حذف المجموعة المحددة "

 (موافق).OKانقر على .3
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يوفر هذا القسم خطوات أساسية لإنشاء مجموعة جديدة وإجراء مسح ضوئي لمجموعة وإخراجها. يمكن العثور استخدام مهمة
على معلومات تفصيلية حول الفهرسة وإعداد مناطق التعرّف الضوئي على الأيقونات، وقراءة رمز المجموعة، 

.Kodak Capture Proوتحديد مصادر إخراج مختلفة، وما إلى ذلك، في دليل المسؤول لبرنامج 

. على سبيل المثال، إذا Capture Proهناك عدة طرق لإكمال إجراء معين عند استخدام برنامج ملاحظة:
(مجموعة > فتح) من شريط القوائم، أو  Batch > Openأردت فتح مجموعة؛ فيمكنك تحديد 
 (فتح المجموعة) أو يمكنك الضغط على مفتاح  Open Batchيمكنك النقر على زر شريط أدوات 

 في هذا الدليل. للحصول على شريط القوائم. يتم وصف جميع الإجراءات باستخدام F3الاختصار 
" في واجهة المستخدم"قائمة كاملة بالقوائم وأزرار شريط الأدوات ومفاتيح الوظائف، راجع 

.17الصفحة

 مسبقاً؛ فقم بتشغيله الآن. يتم عرض مربع حوار مدير Capture Proإذا لم تكن قد قمت بتشغيل برنامج .1
المجموعة.

 (جديد). يتم عرض شاشة المجموعة الجديدة.Newانقر على .2

. يتم إدخال اسم المجموعة ومعرّف مستند اسم المهمةحدد إعداد المهمة المطلوب من مربع القائمة المنسدلة .3
البداية تلقائياً. ويمكنك تغييرهما إذا كنت ترغب في ذلك. 
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سيتم عرض الشاشة الرئيسية وتصبح جاهزًا لبدء المسح الضوئي.   (موافق).OKانقر على .4

ضع رزمة المستندات التي تريد مسحها ضوئياً في درج الإدخال بالماسحة الضوئية..5

 (تشغيل). ستقوم الماسحة الضوئية بتغذية الصفحات.Start انقر على.6

عندما يتم مسح المستندات ضوئيًا، ستتمكن من تنفيذ أي خيارات تعديل ضرورية (مثل إزالة الصفحات .7
 10" في الصفحةخيارات التعديل"الفارغة، أو تدوير الصور، أو اقتصاصها، وغير ذلك). راجع القسم 

للحصول على وصف مختصر لبعض الخيارات المتوفرة.

  (المجموعة > الإخراج).Batch > Outputعندما يتم إعداد المجموعة بالطريقة التي تريدها، حدد .8
تبدأ مهمة إخراج المجموعة ويتم عرض شاشة المجموعة الجديدة مما يتيح لك إمكانية بدء جلسة عمل مسح 

ضوئي أخرى أثناء إجراء المعالجة في الخلفية. 

 لتراخيص المجموعة "أ" و"ب"، يجب تركيب الماسحة الضوئية المادية لإخراج المجموعات. ملاحظة:
عند الحاجة إلى إخراج مجموعة دون تركيب الماسحة الضوئية، يمكن شراء ترخيص فهرسة 

في ذلك الوقت.

يتم تسليم الصور التي تم مسحها ضوئياً إلى الموقع المحدد. 
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قبل إخراج مجموعة، راجع الصور للتأكد من ظهورها بالشكل الذي تريده. وإذا أردت إجراء بعض التعديلات؛ خيارات التعديل
فهناك أدوات متوفرة لهذا الأمر. يوفر هذا القسم إجراءات لبعض وظائف التعديل الأكثر استخدامًا (مثل تدوير 

الصور، وحذفها، واقتصاصها، وما إلى ذلك). ويمكن العثور على إجراءات لتقسيم الصور ودمجها في دليل 
. Kodak Capture Proالمسؤول لبرنامج 

واجهة المستخدم.يتوفر وصف لكل خيارات القوائم وخيارات شريط الأدوات في الفصل الثاني، 

 تدوير الصور تلقائياً أثناء مسحها ضوئياً أو تدويرها يدوياً بعد مسحها ضوئياً. Capture Proيتيح لك برنامج تدوير الصور
 درجة باتجاه عقارب الساعة.270 أو 180 أو 90يمكن تدوير الصور بمقدار 

الحالية يدوياً، قم بما يلي:المجموعةلتدوير الصور الموجودة في 

مستكشف المجموعة أو انقر على صور منفردة (أو مجموعة صور)، أو صفحات، أو مستندات من قائمة .1
.في عارض الصور

. سيتم عرض الصور التي تم تدويرها في عارض 270 أو، 180، أو 90الأدوات > تدوير > حدد .2
الصور.
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تسمح لك الأداة رسم منطقة برسم مستطيل حول أحد أجزاء الصورة، ثم تفريغ المنطقة الموجودة داخل المستطيل رسم منطقة
.الاقتصاص أو اقتصاص الصورة إلى حجم المستطيل باستخدام فارغباستخدام 

انقر على إحدى الصور التي ترغب في اقتصاصها أو تفريغها في عارض الصور..1

 (الأدوات > رسم منطقة). Tools > Draw Regionحدد .2

انقر على مؤشر رسم المنطقة مع السحب لإنشاء مستطيل على الجزء الذي ترغب في تحديده في صورتك. .3
قم بتحرير المؤشر؛ فيصبح لون المستطيل أخضر.

يمكنك الآن اقتصاص المنطقة أو تفريغها..4

لتجاهل منطقة، قم بما يلي:
 Deselect Regionانقر بزر الماوس الأيمن على الصورة التي تحتوي على المستطيل الأخضر وحدد •

(إلغاء تحديد المنطقة).

يمكنك اقتصاص منطقة خارج إحدى المناطق المستطيلة التي قمت بإنشائها باستخدام أداة رسم المنطقة وخيار اقتصاص الصور
الاقتصاص.

انقر على الصورة التي ترغب في اقتصاصها في مستكشف المجموعة. يتم تمييز الصورة التي قمت .1
بتحديدها باللون الأحمر في عارض الصور.

 (الأدوات > رسم منطقة). Tools > Draw Regionحدد .2
انقر على مؤشر رسم المنطقة مع السحب لإنشاء مستطيل على ذلك الجزء من الصورة الذي ترغب في .3

حفظه. قم بتحرير المؤشر؛ فيصبح لون المستطيل أخضر.
 (الأدوات > الاقتصاص). سيتم حذف منطقة الصورة الموجودة خارج المستطيل Tools > Cropحدد .4

الأخضر وستبقى المنطقة المحددة فقط في عارض الصور.

 (نعم) لحفظ إعدادك.Yesانقر على .5
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إذا أردت تفريغ جزء من صورة، يمكنك رسم منطقة على الصورة واستخدام أداة التفريغ. يتم تفريغ المنطقة تفريغ جزء من صورة
الموجودة داخل المستطيل. 

انقر على الصورة المطلوب تفريغها في مستكشف المجموعة..1
 (الأدوات > رسم منطقة). Tools > Draw Regionحدد .2
انقر على مؤشر رسم المنطقة مع السحب لإنشاء مستطيل على ذلك الجزء من الصورة الذي ترغب في .3

تفريغه. قم بتحرير المؤشر؛ فيصبح لون المستطيل أخضر.
 (الأدوات > التفريغ). تظهر عندها الصورة المنطقة الفارغة حيث وضعت Tools > Blankحدد .4

المستطيل الأخضر.
 (نعم) لحفظ إعدادك. Yesانقر على .5

يتيح لك هذا الخيار مسح الصفحات الإضافية ضوئياً في مستند موجود. إرفاق صفحات

، حدد المستند الذي سيتلقى المرفق.مستكشف المجموعةفي .1
 (المستند > إرفاق صفحة).Document > Attach Pageانقر على .2
قم بمسح الصور ضوئياً. يتم عرض الصفحات الجديدة في نهاية المستند المحدد. .3

عند مراجعة مجموعة الصور التي تم مسحها ضوئياً، قد تجد أحياناً أنك في حاجة إلى إعادة مسح بعض إعادة مسح الصور ضوئياً
المستندات يدوياً.

.إعادة مسحها ضوئياً في قم بتمييز الصفحة أو الصفحات التي ترغب.1

.في الماسحة الضوئيةبالترتيب الصحيح  الصفحات الأصلية قم بوضع.2

 (إعادة المسح الضوئي). ستتم إعادة المسح الضوئي للصور ووضعها في Rescanانقر على أيقونة .3
المواضع الأصلية التي تم مسحها ضوئياً.

في حالة الرغبة في حذف الصورة المحددة من مجموعة، قم بما يلي:حذف الصور

حدد الصورة التي ترغب في حذفها..1

هل تريد بالتأكيد حذف العنصر المحدد/ ( تعديل > حذف). سيتم عرض الرسالة Edit > Deleteحدد .2
.العناصر المحددة؟

 (نعم) لتأكيد الحذف.Yesانقر على .3
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يمكنك حذف نطاق من المستندات في مجموعة موجودة.حذف نطاق من المستندات

مربع الحوار حذف  (المستند > حذف النطاق). يتم عرض Document > Delete Rangeحدد .1
.المستندات الموجودة في النطاق

. رقم المستند منأدخل رقم البداية لمجموعة المستندات التي ترغب في حذفها في الحقل.2
.رقم المستند إلىأدخل رقم النهاية لمجموعة المستندات في الحقل .3
 (موافق).OKانقر على .4

يتيح لك هذا الخيار إزالة الصور الخلفية أو الأمامية الفارغة التي تم إنتاجها بواسطة الماسحة الضوئية.إزالة الصور الفارغة من مجموعة

 (المجموعة > إزالة الصور الفارغة). يتم عرض Batch > Remove Blank Imagesحدد .1
.مربع الحوار إزالة إعداد الصور الفارغة

. بدء من المستندأدخل رقم بداية المستند في المجموعة حيث تريد البحث عن الصور الفارغة في الحقل .2
المستند الافتراضي هو المستند النشط الحالي.

عرض الصور بالتدرج الرمادي أقل قم بتحديد حد حجم البايت للصور التي سيتم التحقق منها في الحقلين .3
 نقطة في البوصة بالأبيض والأسود 200 بايت في 3000. تعُد القيمة عرض الصور الملونة أقل منومن 

إعدادًا مناسباً لمستندات الأعمال النموذجية.

 لإزالة الأوجه الخلفية الفارغة فقط من الصورة في مجموعة.التحقق من الأوجه الخلفية فقطانقر على .4

إذا كانت كل الصور مرشحة للحذف.تحديد مسبق للكل انقر على .5
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 1024. على شاشة  تخطيط العرضقم بتحديد عدد الأعمدة والصفوف التي ترغب في عرضها في الحقل.6
 ×768 SVGA صورة لكل شاشة.98 التحقق من 7 × 14، تتيح لك مصفوفة 

 (موافق) لقبول القيم التي قمت بإدخالها. OKانقر على .7

 كل الصور التي تطابق المعايير التي قمت بإعدادها Capture Proبعد فحص المجموعة، يعرض برنامج 
. يتم عرض هذه نافذة إزالة الصور الفارغة بايت) في 5000(على سبيل المثال، الجوانب الخلفية أقل من 

الصور بلون تمييز أحمر. تعتبر كل الصور الملونة فارغة وجاهزة للحذف.

 Capture؛ فهذا يعني أن برنامج نافذة حذف الصور الفارغةإذا لم يتم عرض أي صور فارغة في •
Pro لا يمكنه تحديد موقع الصور في المجموعة التي تطابق المعايير الخاصة بك. يمكنك النقر على 

Setup مربع حوار إزالة إعداد الصور الفارغة (إعداد) على نافذة إزالة الصورة الفارغة لإعادة فتح 
وإدخال أرقام عتبات أعلى (بالبايت) للصور الأبيض والأسود و/أو الملونة/بتدرج الرمادي.

بشكل افتراضي، يتم تحديد كل الصور الفارغة باللون الأحمر وتحديدها للحذف. حدد أيةّ صور فارغة لا .8
ترغب في حذفها من خلال النقر عليها بشكل فردي. يختفي التحديد باللون الأحمر من على هذه الصور.

لمساعدتك على التنقل  الشاشة الأخيرة والشاشة الأولى والشاشة السابقة والشاشة التالية استخدم الأزرار .9
خلال كل الصور الفارغة الممكنة في المجموعة.

.إزالة جميع الصور المحددة؟ (إزالة). سيتم عرض الرسالة Removeانقر على .10

 على إزالة الصور الفارغة Capture Pro (نعم) لتأكيد حذف الصور الفارغة. يعمل برنامج Yesحدد .11
التي لا تزال محددة باللون الأحمر وإعادة تعيين فواصل المستندات وتحديث المجموعة المتوفرة وسعة 

القرص الثابت.
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عند إتمام جميع تغييرات التعديل الخاصة بك، يصبح من الممكن إخراج مجموعتك.إخراج (معالجة) المجموعة الخاصة بك

 إخراج (أو معالجة) مجموعة واحدة في كل مرة أو إخراج كل المجموعات Capture Proيتيح لك برنامج 
المتوفرة في نفس الوقت. 

لإخراج المجموعة الحالية في إعداد مهمة، قم بما يلي:

 (المجموعة > إخراج). Batch > Outputحدد .1

 مما يتيح لك مربع حوار المجموعة الجديدةعند وجود مجموعتك في قائمة انتظار للإخراج، يتم عرض 
إجراء مسح ضوئي لمجموعة أخرى من المستندات. 

لتراخيص المجموعة "أ" و"ب"، يجب تركيب الماسحة الضوئية المادية لإخراج المجموعات. ملاحظة:
عند الحاجة إلى إخراج مجموعة دون تركيب الماسحة الضوئية، يمكن شراء ترخيص فهرسة 

في ذلك الوقت.

 (موافق) لمتابعة مسح الصور ضوئياً في المجموعة الجديدة. عند إخراج إحدى المجموعات، OKانقر على .2
. مربع حوار إعداد المهمة في علامة تبويب المخرجاتتتم معالجتها طبقاً لوجهة مخرج النظام المحددة في 

بشكل نموذجي يؤدي ذلك إلى نسخ المجموعة إلى مسار دليل فرعي لمخرج.

لإخراج جميع المجموعات المتوفرة في إعداد مهمة حالية، قم بما يلي:

 بحيث يتم عرض مربع حوار مدير المجموعة (المجموعة > إخراج الكل). Batch > Output Allحدد •
تتمكن من تحديد مجموعة واحدة أو أكثر ليتم إخراجها. 

، قم بما يلي:الإخراجلعرض تقدم 
 (المجموعة > عرض حالة إخراج المجموعة). Batch > View Batch Output Statusحدد •

. Capture Pro نافذة حالة معالجة مجموعة سيتم عرض

ستعمل هذه النافذة على تحديث تقدم مجموعاتك بمجرد إخراجها. عند الإخراج في الخلفية، تكون الأولوية 
العليا للمسح الضوئي. سيحدث تباطؤ في الإخراج إلى أن ينتهي المسح الضوئي.

 معلومات حول المجموعات التي تقوم بالتحضير للإخراج من برنامج Capture Proتوفر نافذة حالة مجموعة مسح الأخطاء
Capture Pro.

لعرض نافذة حالة المجموعة:

 (المجموعة > عرض حالة إخراج المجموعة).Batch > View Batch Output Statusحدد •

لمسح الأخطاء، قم بما يلي:

مسح الأخطاء  أو لمسح كافة الأخطاءانقر بزر الماوس الأيمن على إدخال اسم المجموعة على الشبكة •
.المحددة
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واجهة المستخدم   2

، بالإضافة إلى وصف لشريط القوائم، Capture Proيوفر هذا الفصل وصفاً للنافذة الرئيسية في برنامج 
وأشرطة الأدوات، والعارضات.

تضم النافذة الرئيسية المكونات التالية.النافذة الرئيسية

يعرض هذا الخيار اسم إعداد المهمة. —شريط عنوان البرنامج 1

، والمستند، والتقاط، والعرض، والمجموعة، الملف — يوفِّر عناصر القائمة التالية: شريط القائمة2
.والتعليمات ، والفهرس، والأدوات، والتعديل

، وشريط أدوات المجموعة، شريط أدوات الالتقاط — توفِّر أشرطة الأدوات التالية: أشرطة الأدوات3
، وشريط أدوات وضع العلامة، وشريط أدوات الانتقال، وشريط أدوات المستند، وشريط أدوات العرض
.وشريط أدوات الفهرس ، وشريط أدوات التعديل

 والصفحات، وملفات الصور في المستندات، — يسرد هذا الخيار كل مجلدات مستكشف المجموعة4
المجموعة. 

 — يعرض هذا الخيار الصور في مجموعة. يمكن تكوين عارض الصور لعرض صورة عارض الصور5
، أو المزيد من الصور في المرة الواحدة.8، أو 4واحدة، أو صورتين، أو 

يعرض هذا الخيار الصورة المصغرّة لكل الصور الموجودة في المجموعة. — عارض الصور المصغرّة6
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 — عندما تقوم بالنقر على علامة تبويب الفهرس (الموجودة في الجانب الأيسر من علامة تبويب الفهرس7
النافذة الرئيسية)، تظهر نافذة الفهرس التي تعرض فهارس مستوى المجموعة أو المستند. 

 — عندما تقوم بالنقر على علامة تبويب المعلومات (الموجودة في الجانب علامة تبويب المعلومات8
الأيسر من النافذة الرئيسية)، تظهر نافذة المعلومات التي تعرض إحصائيات تفصيلية عن المجموعة، 

والمستند، والصفحة، والصورة.
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، الأدوات، والتحرير، والمستند، والتقاط، والعرض، والدفعات، والملفشريط القوائم يوفِّر عناصر القائمة التالية: شريط القوائم
.تعليمات، والفهرسو

تحتوي قائمة الملف على الخيارات التالية: قائمة الملف

، مما يتيح إعداد كل المعلمات لإعداد مهمة. راجع مربع حوار إعداد المهمةيعرض هذا الخيار  —إعداد المهمة 
.J للحصول على مزيد من المعلومات. اختصار لوحة المفاتيح: Kodak Capture Proدليل المسؤول لبرنامج 

، الذي يتيح تحديد إعداد صفحة محددة مسبقاً أو مربع حوار إعداد الصفحة— يعرض هذا الخيار إعداد الصفحة 
 مزودًا بعمليات متنوعة Capture Proإنشاء إعداد صفحة مخصَّصة لإعداد المهمة الخاص بك. يتوفر برنامج 

لإعداد صفحات محددة مسبقاً. تتنوع قائمة عمليات إعداد الصفحات المحددة مسبقاً وفقاً للماسح الضوئي الذي يتم 
استخدامه. راجع دليل المسؤول للحصول على مزيد من المعلومات.

، الذي يتيح لك تحديد الماسحة الضوئية مربع حوار إعداد محطة العمل — يعرض هذا الخيار إعداد محطة العمل
. يمكنك أيضًا تحديد Capture Proالمتصلة بالكمبيوتر الخاص بك لمسح المستندات ضوئياً باستخدام برنامج 

، وذلك إذا كان لديك ترخيص بذلك. راجع Capture Proخيار الاستيراد التلقائي لاستيراد صور إلى برنامج 
 لمعرفة الإجراءات.20" في الصفحةإعداد محطة العمل"

يعرض هذا الخيار مربع حوار التحديد الذكي للمهام، والذي يسمح للمستخدم باستخدام التحديد الذكي للمهام — 
أوراق رموز تصحيح الميزات لتغيير إعدادات المهام أو الصفحة أثناء المسح الضوئي. راجع دليل المسؤول 

للحصول على مزيد من المعلومات.

، الذي يتيح لك استيراد إعداد مهمة. راجع مربع حوار الاستيراد— يعرض هذا الخيار إعداد استيراد المهمة 
دليل المسؤول للحصول على مزيد من المعلومات.

، الذي يتيح لك تصدير إعداد المهمة إلى أحد مربع حوار التصدير— يعرض هذا الخيار تصدير إعداد المهمة 
 للحصول على مزيد من المعلومات.Kodak Capture Proالملفات. راجع دليل المسؤول لبرنامج 

، الذي يتيح للمسؤول إعداد مستخدمي مربع حوار إعداد المستخدم— يعرض هذا الخيار إعداد المستخدم 
 وإدارة بياناتهم. راجع دليل المسؤول للحصول على مزيد من المعلومات.Capture Proبرنامج 

، الذي يتيح لك تغيير كلمة المرور مربع حوار تغيير كلمة المرور — يعرض هذا الخيار تغيير كلمة المرور
الخاصة بك.

لتغيير كلمة مرور:

تغيير كلمة  (الملف > تغيير كلمة المرور). يظهر مربع حوار File > Change Passwordحدد .1
.مرور

.كلمة المرور الجديدة، ثم أدخل كلمة المرور القديمةأدخل .2

.تأكيد كلمة المرورقم بتأكيد كلمة المرور من خلال إدخال كلمة المرور الجديدة في مربع .3

 (موافق). OKانقر على .4

الإنجليزية، والفرنسية،  — يتيح لك هذا الخيار تحديد لغة عرض واجهة المستخدم. اللغات المدعومة هي: اللغة
والإيطالية، والألمانية، والبرتغالية، البرازيلية، والهولندية، والإسبانية، والصينية المبسطة، والصينية 

.اليابانيةوالتقليدية، والسويدية، والكورية، والتركية، والتشيكية، والروسية، والعربية، والبولندية، 
لتغيير اللغة:

 (الملف > اللغة). File > Languageحدد .1

حدد اللغة المطلوبة. سيتم عرض واجهة المستخدم باللغة المحددة..2

قد يتم عرض أحرف نصية غير صحيحة في مربع حوار إعداد جهاز الماسحة الضوئية (برنامج ملاحظة:
) عندما تكون اللغة الافتراضية غربية ويقوم المستخدم بالتغيير إلى لغة آسيوية. لحل TWAINتشغيل 

هذه المشكلة، استخدم خيار "الخيارات الإقليمية وخيارات اللغة" لإعداد "لغة خاصة بالبرامج التي لا 
" على اللغة الآسيوية المطلوبة.Unicodeتستخدم 

.المترية أو الوحدات الولايات المتحدة — يتيح لك هذا الخيار تحديد وحدات نظام القياس

 للطابعة المحددة الذي يتيح لك طباعة المستندات التي مربع حوار إعدادات الطباعة — يعرض هذا الخيار طباعة
.Ctrl + Pتم مسحها ضوئياً. اختصار لوحة المفاتيح: 

، الذي يتيح لك حفظ الصور التي تم  PDFمربع حوار حفظ بتنسيق  — يعرض هذا الخيار PDFحفظ بتنسيق 
 يمكن البحث فيه أو لا يمكن البحث فيه.PDFمسحها ضوئياً بتنسيق 
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— يسمح هذا الخيار بتسجيل خروج المستخدم الحالي.تسجيل الخروج 

 من دون إغلاقه.Capture Pro — يسمح هذا الخيار بتصغير تطبيق برنامج تصغير إلى علبة النظام 

.Alt + F4. اختصار لوحة المفاتيح: Capture Pro — يقوم هذا الخيار بإغلاق برنامج خروج

 (الملف > إعداد محطة العمل)، تعُرض شاشة إعداد محطة File > Workstation Setupعند تحديد إعداد محطة العمل
العمل. من هذه الشاشة يمكن إعداد معلومات محطة العمل واختيار الماسحة الضوئية التي ترغب في استخدامها.

 محطة العمل. في بيئة متعددة الماسحات الضوئية، يجب أن يكون المعرّف والاسم اسم والمعرّفأدخل .1
فريدين.

 عرض إذا كنت مستخدمًا خبيرًا ولا ترغب في استخدام شاشة البدء السريع؛ فقم بإلغاء تحديد مربع اختيار.2
. البدء السريع

سيتم عرض مربع حوار تحديد الماسحة الضوئية الذي يوفر قائمة بأجهزة   (تحديد).Selectانقر على .3
المسح الضوئي المتاحة والمصادر الأخرى مثل الاستيراد التلقائي، حسب الترخيص الذي تمتلكه. 

 (موافق). OKحدد المصدر الذي تريد استخدامه، ثم انقر على .4

أدخل مستوى تحذير القرص المطلوب بالميغابايت. سوف تتلقى تحذيرًا إذا انخفضت المساحة الخالية في .5
القرص عن هذا المستوى.

 إذا كنت تريد حفظ رقم تسلسل المجموعة تمكين التعداد الرقمي للمجموعة الخاصة بمستوى المهمةحدد .6
لكل مهمة بشكل منفصل. في حالة تحديد هذا الخيار، سوف يتم التعداد الرقمي على مستوى المهمة. إذا لم 

 يتم تحديده، سوف يتم التعداد الرقمي على مستوى النظام. على سبيل المثال:

)، فستتلقى KB وأدخلت حجم الصفحة بالكيلو بايت (عرض رسالة التأكيد أثناء الحذف اليدويإذا حددت .7
تحذيرًا عند محاولة حذف صورة تتجاوز حجم الصفحة المحدد.

مستوى المهمةمستوى النظام
INV001فواتير INV001فواتير 

CLM001مطالبات CLM002مطالبات 
RCD001سجلات RCD003سجلات 
INV002فواتير INV004فواتير 
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 Capture إذا كنت تريد إعادة تشغيل برنامج الإزاحة وحد إعادة التشغيل التلقائي للحدأدخل القيم في .8
Pro .تلقائياً عند الوصول إلى هذه الحدود 

، فسيتم إعادة تشغيل برنامج 2 وإزاحة إعادة التشغيل = 5على سبيل المثال، إذا كان حد إعادة التشغيل = 
Capture Pro صفحات ضوئياً في جلسة المسح الضوئي الحالية.7 عند مسح 

 المنبثق إلى أن عدد الأوراق الممسوحة التأكيدعند الوصول إلى حد إعادة التشغيل، يشير مربع حوار 
ضوئياً عند الحد الأقصى ويسأل عما إذا كان ينبغي مواصلة المسح الضوئي حتى يتم الوصول إلى عدد 

 (نعم)، يتم مسح صفحتين أخريين ضوئياً قبل Yesإزاحة الأوراق قبل إعادة التشغيل. إذا تم النقر على 
.Capture Proإعادة تشغيل برنامج 

.8000يوصى بألا يتجاوز حد إعادة التشغيل ملاحظة:

حد إعادة  على الفور ويكون خيار Capture Pro (لا)، فسيتم إعادة تشغيل برنامج Noإذا تم النقر على .9
 باللون الرمادي عند استئناف المسح الضوئي.التشغيل التلقائي

تحتوي قائمة الدفعات على الخيارات التالية:قائمة المجموعة

، والذي يتيح لك إمكانية إنشاء مجموعة جديدة.مربع حوار المجموعة الجديدة — يعرض هذا الخيار جديد

، والذي يتيح لك فتح مجموعة موجودة. اختصار لوحة المفاتيح: مربع حوار إدارة المجموعة — يعرض فتح
F3 لمعرفة الإجراءات.1" في الصفحةبدء الاستخدام". راجع 

لإغلاق المجموعة المفتوحة حالياً.إغلاق — 

، والذي يتيح لك إعادة تسمية المجموعة مربع حوار إعادة تسمية المجموعة — يعرض هذا الخيار إعادة تسمية
الحالية.

، والذي يتيح لك إزالة مربع حوار إعداد إزالة الصور الفارغة — يعرض هذا الخيار إزالة الصور الفارغة
بدء ". راجع Kالصور الفارغة الأمامية أو الخلفية التي تنتجها الماسحة الضوئية. اختصار لوحة المفاتيح: 

 لمعرفة الإجراءات.1" في الصفحةالاستخدام

" في بدء الاستخدام". راجع O — لبدء معالجة كل الصور في المجموعة الحالية. اختصار لوحة المفاتيح: إخراج
 لمعرفة الإجراءات.1الصفحة

لتراخيص المجموعة "أ" و"ب"، يجب تركيب الماسحة الضوئية المادية لإخراج المجموعات. عند ملاحظة:
الحاجة إلى إخراج مجموعة دون تركيب الماسحة الضوئية، يمكن شراء ترخيص فهرسة في ذلك 

الوقت.

 — لبدء معالجة كل الصور الموجودة في كل المجموعات في المهمة الحالية. إخراج الكل

 Captureنافذة حالة معالجة المجموعة الخاصة ببرنامج — يعرض هذا الخيار عرض حالة إخراج المجموعة 
Pro نافذة حالة معالجة "، والتي توفر معلومات حول مستوى تقدم مجموعات الإخراج الخاصة بك. انظر

.43" في الصفحةالمجموعة

 — يقوم هذا الخيار بإزالة كل الصور الموجودة في مجموعة معينة، مع عدم المساس بهيكل الدليل الفرعي مسح
للمجموعة.

" بدء الاستخدام" — يقوم هذا الخيار بإزالة كلٍ من الصور وهيكل الدليل الفرعي للمجموعة المحددة. راجع حذف
 لمعرفة الإجراءات.1في الصفحة

 — يقوم هذا الخيار بإزالة كل الصور من الصور المحددة حتى آخر صورة في حذف حتى نهاية المجموعة
المجموعة.
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تحتوي قائمة العرض على الخيارات التالية:قائمة العرض

 8، أو 4 — يتيح لك هذا الخيار تحديد شبكة تتكون من صورة واحدة، أو صورتين، أو عرض عارض الصور
 الذي يتيح لك مربع حوار إعداد التخطيط المخصص يتم عرض تخصيص. عند تحديد النافذة الرئيسيةصور في 

تحديد حجم شبكة آخر.

عارض — يتيح لك هذا الخيار تحديد نوع واحد أو أكثر من الصور التي سيتم عرضها في منقي عارض الصور 
أمامي، وخلفي، وأبيض وأسود، وبتدرج  في النافذة الرئيسية. يمكنك تحديد واحد أو أكثر مما يلي: الصور

. ملونوالرمادي، 

 — يتيح لك هذا الخيار تحديد نوع واحد أو أكثر من الصور التي سيتم عرضها منقي عارض الصور المصغرّة
 أمامي،  في النافذة الرئيسية. يمكنك اختيار واحد أو أكثر من المنقيات التالية:عارض الصور المصغرّةفي 

. ملونووخلفي، وأبيض وأسود، وبتدرج الرمادي، 

، الذي يتيح لك تحديد  مربع حوار إعداد حجم الصورة المصغرّة— يعرض هذا الخيارحجم الصورة المصغّرة 
حجم كل صورة مصغرّة سوف يتم عرضها في النافذة الرئيسية.

— تتيح عارض الصور، مستكشف المجموعة، عارض الصور المصغرّة، المعلومات، الفهرس، شريط الحالة 
لك هذه الأوامر تحديد ما إذا كانت المكونات المناسبة معروضة في النافذة الرئيسية أم لا. اختصار لوحة المفاتيح 

.Ctrl + Sلشريط الحالة هو 

وشريط أدوات ، شريط أدوات الالتقاط — تتيح لك عرض أو إخفاء أشرطة الأدوات التالية: أشرطة الأدوات
وشريط أدوات وضع ، وشريط أدوات الانتقال، وشريط أدوات المستند، وشريط أدوات العرض، المجموعة

. يمكن العثور على معلومات تفصيلية حول أشرطة وشريط أدوات الفهرس، وشريط أدوات التعديل، العلامة
الأدوات فيما يلي من هذا الفصل.

.كبير أو صغير أومتوسط — يتيح لك هذا الخيار تحديد حجم الأيقونات حجم الأيقونة

— يتيح لك هذا الخيار تحديد ما إذا كان سيتم عرض تسميات الأيقونات على يمين الأيقونات أو نص الأيقونة 
أسفلها، أم لا.

 — يتيح لك هذا الخيار زيادة حجم الصور المعروضة أو تصغيره. تكبير/تصغير

: يعرض هذا الخيار الصور بحجمها الفعلي (وحدة بكسل واحدة تم مسحها ضوئيًا تساوي وحدة بكسل فعلي•
واحدة في عارض الصور).

مربع حوار إعداد خطوة يسُتخدم هذا الخيار في تكبير عرض الصورة بمقدار القيمة المحددة في  :تكبير•
.التكبير/التصغير

: يسُتخدم هذا الخيار في تصغير عرض الصورة بمقدار القيمة المحددة في مربع حوار إعداد خطوة تصغير•
التكبير/التصغير.

: يعرض هذا الخيار مربع حوار إعداد خطوة التكبير/التصغير، الذي يتيح لك تحديد درجات التكبير/التصغير•
) في حجم الصورة عند 40%أو، 35، أو %30، أو %25 ،أو %20، أو %15%مقدار التغيير (

استخدام الأمرين تكبير وتصغير.

نك هذا الخيار من تحريك جميع الصور الموجودة حول جزء عارض الصور تحريك جميع الصور إلى   — يمُكِّ
مرة واحدة. يمكنك تحريك الصور إلى أعلى، أو أسفل، أو إلى اليسار، أو إلى اليمين.

، الذي يتيح لك تعيين عدد مربع حوار إعداد خطوة التحريك — يعرض هذا الخيار إعداد خطوة التحريك 
) في صورة ما عند استخدام أوامر 100 أو 50، أو 25، أو 15، أو 10، أو 5وحدات البيكسل المطلوبة (

التحريك.

.المحسّن والكلاسيكي — يتيح لك هذا الخيار التغيير بين وضعي التخطيط تخطيط

— يوفر قائمة بالوظائف ولوحات المهام شائعة الاستخدام.البدء السريع 



A-61992_ar 202223  مارس

تحتوي قائمة التقاط على الخيارات التالية:قائمة التقاط

.F7لتمكين الماسح الضوئي وبدء عملية النقل. اختصار لوحة المفاتيح: تشغيل — 

.F6لمسح النقل وإيقافه وتعطيل الماسح الضوئي. اختصار لوحة المفاتيح: إيقاف — 

، الذي يتيح لك الاختيار من عمليات مربع حوار قائمة إعداد الصفحة — يعرض هذا الخيار قائمة إعداد الصفحة
.F2إعداد الصفحة المحددة. اختصار لوحة المفاتيح: 

 — يحدد هذا الخيار كيفية إجراء المسح الضوئي لإحدى المجموعات من خلال السماح لك أوضاع الالتقاط
بتحديد أحد الإعدادات التالية:

: يتيح إجراء المسح الضوئي لوجهي الصفحة.وجهان•
: يتيح إجراء المسح الضوئي للوجه الأمامي للصفحة.وجه واحد أمامي•
: يتيح إجراء المسح الضوئي للوجه الخلفي للصفحة.وجه واحد خلفي•

، الذي يتيح لك تحديد الماسحة مربع حوار إعداد محطة العمل — يعرض هذا الخيار اختيار الماسحة الضوئية
الضوئية المطلوب استخدامها.

 — يتيح لك استيراد ملفات الصور التي تم إنشاؤها من مصدر آخر (على سبيل المثال، الاستيراد اليدوي للصور
. Capture Proالماسحة الضوئية للرسوم الهندسية) إلى المستند المعروض الحالي في برنامج 

، سيظهر مربع حوار فتح. انتقل إلى الدليل الذي تريد استيراد الصور  الاستيراد اليدوي للصورعندما تقوم بتحديد
، JPEG، وBMPمنه، ثم حدد ملف (ملفات) الصور المطلوبة. يمكن استيراد ملفات الصور بتنسيقات 

. سيتم على الفور إدراج الصور التي PNG، وCMP، وGIF، وMODCA، وIOCA، وTIFF، وPDFو
قمت بتحديدها للاستيراد قبل الصورة المحددة في المستند المعروض حالياً. إذا لم تكن هناك صور محددة، سيتم 

إلحاق الصور المستوردة في نهاية المستند الحالي.

 متعدد الصفحات، يتم TIFF ذات الصفحة الواحدة أو متعددة الصفحات معتمدة. عند استيراد ملف TIFFملفات 
استيراد كل صفحة في الملف كصورة منفصلة في المستند.

يمكن تحديد أكثر من صورة للاستيراد. في حالة تحديد أكثر من صورة واحدة، يتم استيراد الصور بترتيب 
أبجدي/رقمي حسب اسم ملف الصورة.

 — يعرض هذا الخيار جدول بجميع مهام الاستيراد التلقائي المرسلة إلى عرض مهام الاستيراد التلقائي المعلقة
 الاستيراد التلقائي (واجهة برمجة التطبيق) التي لم تكتمل بعد. API باستخدام Capture Proبرنامج 

 — يعرض هذا الخيار مربع حوار إعداد الاستيراد التلقائي الذي يتيح لك تكوين إعداد الاستيراد التلقائي 
استيراد "مجلدات المراقبة" التلقائي. يمكنك تحديد مجلدات المراقبة وتعيين أسماء مألوفة لها باستخدام مربع حوار 

الإعداد التلقائي للصورة. يمكنك أيضاً تحديد دلائل الأرشفة ومعالجة خطأ وتعيين مستويات حد خطأ وتحديد 
 Kodakقواعد تجزئة المجموعة للاستيراد التلقائي والفواصل الزمنية للمهل. راجع دليل المسؤول لبرنامج 

Capture Proالمعلومات للحصول على مزيد من .

، الذي يتيح لك تغيير إعدادات عنوان مربع حوار عنوان الصفحة — يعرض هذا الخيار تعيين عنوان الصفحة
الصفحة للمجموعة الخاصة بك. يتم تنشيط هذا الخيار إذا كنت تستخدم ماسحاً ضوئياً قادرًا على توجيه الصور.

، الذي يتيح لك إعادة تعيين قيمة العداد التسلسلية مربع حوار تعيين العداد— يعرض هذا الخيار تعيين العداد 
المعينة (والمطبوعة اختيارياً) للصفحة التالية التي تم مسحها ضوئياً. يتم تنشيط هذا الخيار فقط إذا كنت تمتلك 

ماسحة ضوئية مزودة بعداد.
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تحتوي قائمة المستند على الخيارات التالية:قائمة المستند

". 1 — يسُتخدم هذا الخيار في إنشاء مستند جديد برقم مستند يساوي رقم آخر مستند بالإضافة إلى "جديد
.Ctrl + Enterاختصار لوحة المفاتيح: 

 تمكين الماسحة الضوئية جديدبالنسبة لبعض أجهزة المسح الضوئي، يترتب أيضًا على تحديد الخيار ملاحظة:
وتشغيل نقل/وحدة التغذية أو السطح المستوي للماسحة الضوئية.

— يتيح لك هذا الخيار إجراء مسح ضوئي لصفحات إضافية وإضافتها كصفحات لمستند موجود. إرفاق صفحة 
.F4اختصار لوحة المفاتيح: 

 — يتيح لك هذا الخيار إدراج صفحات إضافية في مستند تم مسحه ضوئياً. اختصار لوحة إدراج الصفحات
المفاتيح: إدراج.

إذا تم تعيين عنوان الصورة واكتشاف التصحيح؛ فلن يؤدي خيار إدراج الصفحات إلى فصل مستند ملاحظة:
عند اكتشاف تصحيح مستند. 

 — يشُغلّ الماسحة الضوئية ويستبدل الصفحات المحددة من المستند بالصفحات إعادة مسح الصفحات ضوئياً
.Rالممسوحة ضوئياً حديثاً. اختصار لوحة المفاتيح: 

 — يقسم المستند الحالي إلى مستندين عند نقطة الصفحة المحددة.تقسيم المستند

 — يسمح هذا الخيار بوضع المستند الذي يتم إجراء مسح ضوئي له حالياً في مستند آخر.دمج في السابق

.F8 — يقوم هذا الخيار بحذف المستند المفتوح حالياً. اختصار لوحة المفاتيح: حذف

، الذي يتيح لك حذف مربع حوار حذف المستندات الموجودة في النطاق — يعرض هذا الخيار حذف النطاق
نطاق من المستندات موجود في مجموعة.

 — يتيح لك هذا الخيار حذف الصورة المحددة وكل الصور التالية لأحد المستندات. حذف حتى نهاية المستند
يسُتخدم هذا الأمر في إزالة الصور من القرص الثابت. ولا يمكن التراجع عن إجراء هذه الوظيفة.

 — يتيح لك هذا الخيار اختيار الانتقال إلى المستند الأول، أو الأخير، أو السابق، أو اللاحق الانتقال إلى المستند
في المجموعة أو يمكنك اختيار رقم مستند للانتقال إلى مستند معين في مجموعة.

 الذي يتيح لك الانتقال إلى مربع حوار الانتقال إلى الصورة، — يسُتخدم هذا الخيار في فتح الانتقال إلى الصورة
صورة معينة في المستند الحالي. اختصار لوحة المفاتيح: ي.
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تحتوي قائمة التحرير على الخيارات التالية:تحرير القائمة

 — يسُتخدم هذا الخيار في تراجع مستوى واحد عن آخر إجراء. في حالة وجود إجراء لا يمكن التراجع تراجع
.Ctrl + Zعنه، سيتم عرض رسالة. اختصار لوحة المفاتيح: 

 Ctrl — يسُتخدم هذا الخيار في نسخ صورة محددة من أجل لصقها في موقع آخر. اختصار لوحة المفاتيح: نسخ
 +C.

 من أجل إنشاء منطقة في الصورة، يتيح لك هذا الخيار رسم منطقة — بعد استخدام خيار نسخ منطقة الصورة
.Ctrl + Iنسخ هذه المنطقة إلى موقع آخر. اختصار لوحة المفاتيح: 

 الذي يتيح لك مربع حوار نسخ الصورة إلى إعداد المهمة — يعرض هذا الخيار نسخ الصورة إلى إعداد المهمة
 من أجل إنشاء رمز نافذة التعرّف الضوئي على الرموز  أو نافذة الأيقونة الشريطي،استيراد الصور في 

شريطي، أو مناطق تعرّف ضوئي على الرموز.

 — يسُتخدم هذا الخيار في اختيار كل الصور الموجودة في المجموعة الحالية. اختصار لوحة اختيار الكل
.Ctrl + Aالمفاتيح: 

 — يسُتخدم هذا الخيار في تحديد كل الصور في المستند الحالي.اختيار المستند

 — يسُتخدم هذا الخيار في تحديد كل الصور التي تم تحديد المعلمات التي تمت تصفيتها لها.اختيار المُنقى

.Ctrl + D — يسُتخدم هذا الخيار في إلغاء اختيار كل الصور. اختصار لوحة المفاتيح: إلغاء اختيار الكل

 — يسُتخدم هذا الخيار في تحديد كل الصور التي تم وضع علامة لها. اختصار اختيار ما تم وضع علامة له
.Ctrl + Fلوحة المفاتيح: 

— يسُتخدم هذا الخيار في حذف الصور المحددة من المجموعة. اختصار لوحة المفاتيح: حذف.حذف 
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تحتوي قائمة الأدوات على الخيارات التالية:قائمة الأدوات

 — يعرض هذا الخيار أداة المؤشر التي تتيح لك تحديد الصور. كما يمكنك تحديد الصور باستخدام أداة الاختيار
أدناه. اختصار لوحة المفاتيح: المقيّدةالتكبير أداة التكبير. راجع 

.  وجه الصفحةأوصورة أو صفحة  — يسمح هذا الخيار بالتحديد من بين وضع الاختيار

 يمكنك النقر على إحدى الصور في عارض الصور وسوف يتم تحديد الصورة،في حالة تحديد الخيار •
الصورة على الفور.

، يمكنك النقر على الصورة والصفحة بالكامل وسيتم تحديد الوجه الأمامي والخلفي الصفحةفي حالة تحديد •
والأبيض والأسود والملون/بتدرج الرمادي.

، وجه الصفحةإذا كنت تقوم بإجراء مسح ضوئي لعدة صور (مسح الدفع المزدوج الضوئي)، فعند تحديد •
والنقر على صورة أمامية، سيتم تحديد جميع الصور الأمامية. إذا قمت بالنقر على الوجه الخلفي للصورة، 

فيتم تحديد كل الأوجه الخلفية.

، يتم عرض أداة التكبير. يمكنك تكبير تكبير — يسُتخدم هذا الخيار في تكبير جزء من صورة. عند تحديد تكبير
أية منطقة تضع عليها أداة التكبير. (انقر مطولاً على زر الماوس الأيسر لتكبير الصورة. سيتم تحديد الصورة 

.Mعبر النقر على زر الماوس الأيسر). اختصار لوحة المفاتيح: 

 عندما تكون الصورة أكبر من الجزء. عارض الصور — يتيح لك هذا الخيار تحريك الصورة حول جزء تحريك
. سيتم تحديد الصورة عبر النقر على زر الماوس الأيسر.Pاختصار لوحة المفاتيح: 

 — يتيح لك هذا الخيار رسم مستطيل حول جزء من صورة، بعد ذلك يمكنك تفريغ منطقة المستطيل رسم منطقة
(أو نسخها اقتصاص  أو اقتصاص الصورة بحجم المستطيل باستخدام الخيار تفريغ؛الداخلية باستخدام الخيار 

 (تعديل > نسخ منطقة الصورة)).Edit > Copy Image Area باستخدام

، الذي يتيح لك تحديد نسبة التكبير المطلوبة مربع حوار إعداد نسبة التكبير — يعرض هذا الخيار نسبة التكبير
.300 %أو، 250، أو %200، أو %150، أو 100%%

لتكبير صورة موجودة في عارض الصور أو عارض الصور المصغرّة:

 (الأدوات > تكبير).Tools > Magnifyحدد .1

انقر على صورة مطولاً، ثم اسحب أداة التكبير على الصورة..2

 درجة يدوياً باتجاه عقارب 270، أو 180، أو 90 — يسمح هذا الخيار بتدوير صورة محددة بزاوية تدوير
 تدوير الصور تلقائياً أثناء مسحها ضوئيًا أو تدويرها يدويًا بعد مسحها Capture Proالساعة. يتيح لك برنامج 

ضوئياً.

— يتيح لك هذا الخيار تشغيل أداة مراقبة الجودة الذكية. سيتم توفير جميع الصور المحددة مراقبة الجودة الذكية 
للمراجعة والمعالجة. إذا لم يتم تحديد أية صور، فستتوفر جميع الصور التي تم وضع علامة عليها. كما يمكن 
تشغيل أداة مراقبة الجودة الذكية من خلال النقر بزر الماوس الأيمن على إحدى الصور الموجودة في عارض 

الصور أو مستكشف المجموعة، ثم تحديد مراقبة الجودة الذكية في قائمة التحديد. للمزيد من المعلومات، يرُجى 
.27" في الصفحةمربع حوار أداة مراقبة الجودة الذكية"الاطّلاع على 
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 (الصور) التي قد تحتاج إلى الصورة — يتيح لك هذا الخيار وضع علامة على خيارات أداة وضع العلامة
مسحها ضوئياً مرة أخرى أو ضبطها بطريقة ما (على سبيل المثال، قد تحتاج قيم التباين إلى ضبط من أجل 

.Cتحسين جودة الصورة). اختصار لوحة المفاتيح: 

: يتيح لك هذا الخيار وضع علامة على صفحة، أو صورة، أو كليهما، أو على الوجه أداة وضع العلامة•
الأمامي، والوجه الخلفي لصورة.

: يسُتخدم هذا الخيار في وضع علامة على كل الصور المحددة في المجموعة وضع علامة على كل المُحدد•
المطلوب إعادة المسح الضوئي لها.

: يسُتخدم هذا الخيار في وضع علامة على المستند المحدد.وضع علامة على المستند•

: يتيح لك هذا الخيار استخدام التصفية مع الصور المعروضة حالياً وضع علامة على الصور التي تم تصفيتها•
الوجه  بمجرد أن تقوم باختيار العارض الذي تريد استخدام التصفية معه، يمكنك تحديد عارض الصور.في 

. ألوانأو الوجه الخلفي، أو صور الأبيض والأسود، أو تدرج الرمادي، أوالأمامي، 

: يسُتخدم هذا الخيار في إزالة العلامات عن الصور المحددة حالياً.إلغاء وضع علامة على كل المُحدد•

يسُتخدم هذا الخيار في إزالة أي صور تم وضع علامة عليها مسبقاً في  :إلغاء وضع العلامة على الكل•
المجموعة الحالية. 

 — يستخدم هذا الخيار في تقسيم المستند المحدد إلى مستندين.تقسيم المستند

 — يتيح لك هذا الخيار اقتصاص المنطقة خارج المستطيل الذي قمت بإنشائه باستخدام خيار رسم اقتصاص
. Ctrl + Rمنطقة. يتم عرض مربع تأكيد عند تحديد هذا الخيار. اختصار لوحة المفاتيح: 

 — يتيح لك هذا الخيار تفريغ المنطقة خارج المستطيل الذي قمت بإنشائه باستخدام خيار رسم منطقة. يتم تفريغ
. Ctrl + Bعرض مربع تأكيد عند تحديد هذا الخيار. اختصار لوحة المفاتيح: 

 — تضع علامة على الصور كفارغة عند تحديد هذا الخيار إما من قائمة الأدوات أو بالنقر وضع علامة كفارغة
بزر الماوس الأيمن على صورة محددة. يتم التعرّف على الصورة الفارغة بحدود زرقاء داكنة. سيؤدي تحديد 

هذا الخيار على صورة تم تحديدها بالفعل إلى إلغاء تحديد الصورة. متوفر فقط عند تمكين خيار "الاحتفاظ 
بالصور الفارغة" ضمن "الحذف التلقائي" لإعداد الصفحة المحددة حالياً.

يترتب على تحديد أيقونة مراقبة الجودة الذكية في شريط أدوات التعديل، تشغيل أداة مراقبة الجودة الذكية. سيتم مربع حوار أداة مراقبة الجودة الذكية
توفير جميع الصور المحددة للمراجعة والمعالجة. إذا لم يتم تحديد أية صور، فستتوفر جميع الصور التي تم 

وضع علامة عليها. كما يمكن تشغيل أداة مراقبة الجودة الذكية من خلال النقر بزر الماوس الأيمن على إحدى 
الصور الموجودة في عارض الصور أو مستكشف المجموعة، ثم تحديد مراقبة الجودة الذكية في قائمة التحديد.
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لا تتوفر أداة مراقبة الجودة الذكية أثناء إجراء المسح الضوئي أو إعادته أو إذا كانت وظيفة الاستيراد التلقائي 
تراقب المجلد الفعال لملفات الصور بنشاط.

عند تحديد الأداة، يتم عرض الصورة الأولى في لوحة الصور اليسرى. وتعرض لوحة الصور اليسرى شكل 
الصور من دون إجراءات المعالجة الإضافية.

وتعرض لوحة الصور اليمنى شكل الصور إذا تم تنفيذ معالجة الصور المحددة عليها.

يمكنك تحرير الصورة من خلال النقر على واحدة أو أكثر من أدوات معالجة الصور الموجودة بين لوحات 
الصور. للتراجع عن وظيفة معالجة صور معينة، انقر على الأداة مرة أخرى لإلغاء تحديدها.

توفر بعض أدوات معالجة الصور عناصر تحكم إضافية لضبط مظهر الصورة. على سبيل المثال، توفر أداة 
التثنية عنصر التحكم في التباين. يترتب على ضبط التباين تمكينك من رؤية النصوص الباهتة جدًا مع تثبيت 

تشويش الخلفية في المستويات المقبولة.

 — عند تحديد هذا الخيار، يتم استخدام أدوات معالجة الصور المحددة تطبيق الإعدادات على الصورة التالية
 وكانت الصورة التالية أبيض تثنيةحالياً وتطبيق إعدادات الأداة على الصورة التالية عند اللزوم. في حالة تحديد 

 أيضًا، سيتم تطبيقه على الصورة الأبيض والأسود. ملء الفراغوأسود، لن تتم تثنية الصورة. لكن إذا تم تمكين 

 الصور المحددة باستخدام كل— يقوم هذا الخيار بتطبيق أدوات معالجة الصور المحددة على تطبيق على الكل 
أداة مراقبة الجودة.

 حفظ التالي — إذا توفرت صور إضافية للمراجعة؛ فسيظهر زر التالي. يترتب على النقر على زر التالي
، يتم تطبيق أدوات تطبيق على التاليةالصورة الحالية كما هي معروضة في لوحة الصور اليمنى. في حالة تحديد 

معالجة الصور المحددة على الصورة التالية. تعرض الصورة قبل المعالجة في لوحة الصور اليسرى، بينما 
تعرض الصور المعالَجة في لوحة الصور اليمنى. 

 — يعرض هذا الخيار الصورة التي سبق عرضها. يتم تعطيل كل تحديدات الأدوات ويتم إلغاء تحديد رجوع
 (التالي).Next. يتم عرض الصورة كما كانت عند تحديد زر تطبيق على التاليةالخيار 

 — في حالة وجود صور بتدرج الرمادي / الألوان وصورة عرض أبيض وأسود / تدرج الرمادي / الألوان
بالأبيض والأسود مرتبطة بها (الدفق المزدوج)، يتم عرض الصورة بالأبيض والأسود في لوحة الصور 

 (عرض View Grayscale/Colorاليسرى. لعرض صورة بتدرج الرمادي / الألوان، انقر على زر 
تدرج الرمادي/الألوان).
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تحتوي قائمة الفهرس على الخيارات التالية:قائمة الفهرس

 المجموعة— يوفر هذا الخيار إمكانية الوصول إلى حقول الفهرس على مستويات تعديل حقول الفهرس 
.Eوالمستند. اختصار لوحة المفاتيح: 

لتراخيص المجموعة "أ" و"ب"، يجب تركيب الماسحة الضوئية المادية لتعديل حقول الفهرسة. عند ملاحظة:
الحاجة إلى فهرس دون تركيب الماسحة الضوئية، يمكن شراء ترخيص فهرسة في ذلك الوقت.

.F9— يعرض هذا الخيار معلومات الفهرس للمستند السابق. اختصار لوحة المفاتيح: المستند السابق 

.F10— يعرض هذا المستند معلومات الفهرس للمستند التالي. اختصار لوحة المفاتيح: المستند التالي 

 — يعرض هذا الخيار معلومات الفهرس للمستند التالي الذي يحتوي على فهرس غير صالح. غير الصالح التالي
.F11اختصار لوحة المفاتيح: 

 — يتيح لك هذا الخيار توضيح أن المجموعة جاهزة للفهرسة.1فهرس

 — يتيح لك هذا الخيار توضيح أن المجموعة جاهزة لإدخال الفهرس الثاني باستخدام إدخال البيانات 2فهرس
المزدوج.

عند استخدام إدخال البيانات المزدوج، إذا كنت، بصفتك مشغل الالتقاط، تقوم بإدخال قيمة (قيم) ملاحظة:
 عندما تكون المجموعة جاهزة للإدخال 2، ثم فهرس1الفهرس الأولى، يجب أن تختار أولاً فهرس

استخدام إدخال "الثاني لقيم الفهرس. لمزيد من المعلومات حول الإدخال المزدوج للبيانات، راجع 
.30" في الصفحةالبيانات المزدوج

 — يتيح لك هذا الخيار تعيين إجراء تريد أن يقوم البرنامج بتنفيذه عند الضغط على Enterاختيار سلوك مفتاح 
Enter :حفظ أوالانتقال إلى المستند التالي أو الانتقال إلى المستند التالي غير الصالح . الخيارات هي 

.الفهرسة والإنهاء

 — يتيح لك هذا الخيار رسم مستطيل حول جزء من الصور مطلوب تكبيره/تصغيره مناطق التكبير/التصغير
لعرضه عند تعديل حقول الفهرس. يتم حفظ إعداد التكبير/التصغير لكل حقل فهرس. ونتيجة لذلك، يمكنك تحديد 
منطقة تكبير/تصغير لكل حقل فهرس ويقوم عرض الصورة بالتكبير/التصغير تلقائياً للجزء المناسب من الصورة 

عند تعديل هذا الحقل.

 — يتيح لك هذا الخيار ملء حقل فهرس من خلال من خلال السحب والإفلاتالتعرّف الضوئي على الرموز 
رسم منطقة على الصورة. يتم التعرّف الضوئي على الرموز في المنطقة ويتم وضع القيمة تلقائياً في حقل 

الفهرس. بعد تحديد الأداة، قم برسم مستطيل حول بيانات الفهرس المطلوب التقاطها. 

لإنشاء أحرف لغوية خاصة من أجل التعرّف الضوئي على الرموز بشكل صحيح (مثل « أو ،) أو ملاحظة:
 من القائمة المنسدلة.MICR، حدد اللغة المناسبة أو حجم خط MICRأحرف رمز 

— يتيح لك النقر على كلمة أو قيمة واحدة لتعيين حقل الفهرس نقرة واحدة على التعرف الضوئي على الرموز 
. وانقر على الكلمات أو القيم الإضافيةCtrlالمحدد. لإلحاق عدة كلمات أو قيم، اضغط على مفتاح 

 — يتيح لك هذا الخيار إعداد اللغة التي سيتم استخدامها في وظيفة التعرّف لغة التعرّف الضوئي على الرموز
الضوئي على الرموز. 

 — يسُتخدم هذا الخيار في الخروج من الفهرسة وحفظ أي تغييرات تمت على حفظ الفهرسة والخروج منها
.F12المجموعة. اختصار لوحة المفاتيح: 

 — يسُتخدم هذا الخيار في الخروج من الفهرسة من دون حفظ أي تغييرات تمت إلغاء الفهرسة والخروج منها
.Escعلى المجموعة. اختصار لوحة المفاتيح: 



30A-61992_ar 2022  مارس

)، سيتم إجراء فهرس > تعديل حقول الفهرسبعد إجراء المسح الضوئي ودخول المستخدم في وضع الفهرس (استخدام البحث في قاعدة البيانات
البحث دائمًا على مستند كلما تم الانتقال إلى المستند أثناء التواجد في وضع الفهرسة.

إذا كان حقل الفهرس المستخدم للبحث يشتمل على قيمة بالفعل (على سبيل المثال: من رمز شريطي أو التعرف 
الضوئي على الرموز النطاقي)؛ فسيتم تنفيذ بحث عن مستند تلقائياً عند التنقل إلى المستند.

إذا كان يتم إدخال البيانات يدوياً في حقل الفهرس؛ فسيتم تنفيذ البحث عندما يترك المستخدم حقل الفهرس. إذا تم 
 عن حقل الفهرس الذي تم دخوله للتو؛ فستظهر النتائج التي تملأ حقول بعيدًا للانتقال التبويباستخدام مفتاح 

 أو أحد مفاتيح وظائف وضع الفهرسة الأخرى (على Enterالفهرس الأخرى للتحقق منها. إذا تم استخدام مفتاح 
؛ فسيتم تنفيذ البحث وسيتم ملء حقول الفهرس آخر) للانتقال إلى مستند F11، وF10، وF9سبيل المثال: 

الأخرى. ومع ذلك؛ فلن ترى نتائج البحث لأن هذا المستند لم يعد يتم عرضه في وضع الفهرسة.

إذا تم ملء حقل فهرس البحث باستخدام السحب والإفلات عن طريق التعرف الضوئي على الرموز؛ فسيتم تنفيذ 
البحث على الفور وسيتم عرض نتائج ملء حقول الفهرس الأخرى للتحقق منها.

إذا كانت القيمة المستخدمة للبحث معروفة جزئياً فقط، فسيتم استخدام العلامة النجمية ' * ' لتحل محل الحرف 
(الحروف) غير المعروف (المعروفة). يجب أن تكون العلامة النجمية هي الحرف الأخير. على سبيل المثال، إذا 

كانت قيمة البحث هي رقم هاتف ولكن الأرقام الأربعة الأولى فقط هي سهلة القراءة؛ فإن القيمة التي يمكن 
 من قاعدة البيانات وقد                      إدخالها هي              . سيتم استرجاع جميع أرقام الهاتف التي تبدأ بـ 

تقوم بتحديد القيمة الصحيحة.

عندما يستند البحث على قيمتين وتكون قيمة واحدة فقط هي المعروفة؛ فقد يتم استخدام العلامة النجمية في مكان 
القيمة غير المعروفة. على سبيل المثال، يستند البحث على الاسم_الأخير والاسم_الأول، وسيتم البحث عن 

العنوان. في حالة كان الاسم الأخير فقط هو المعروف؛ فسيتم إدخاله في حقل الفهرس "الاسم الأخير" وسيتم 
إدخال العلامة النجمية في حقل الفهرس "الاسم الأول". في حالة العثور على سجل واحد للاسم الأخير الذي تم 

إدخاله، سيتم ملء الاسم الأول والعنوان. في حالة العثور على سجلات متعددة للاسم الأخير، سيظهر مربع حوار 
النتائج المتعددة وسيتم اختيار الإدخال الصحيح. 

يتم استخدام أي مهمة تحتوي على مجموعة واحدة أو أكثر أو حقول فهرس مستند مكونة للإدخال المزدوج في استخدام إدخال البيانات المزدوج 
إجراء المسح الضوئي للمستندات مثل أي مهمة أخرى.

. 1فهرس > فهرسعندما يكتمل المسح الضوئي للمستند وتكون المجموعة جاهزة للفهرسة، يحدد المشغل 
 بمعنى أن المجموعة جاهزة لإدخال أول ،1 إلى فهرسمتوفريترتب على هذا الإجراء تغيير حالة المجموعة من 

مجموعة من قيم الفهرس.

. يترتب 2فهرس > فهرسعندما يقوم مشغل الفهرس الأول بإدخال قيم الفهرس لكل المستندات، يحدد الخيار 
، بمعنى أن المجموعة جاهزة الآن لإدخال 2فهرس إلى 1فهرسعلى هذا الإجراء تغيير حالة المجموعة من 

المجموعة الثانية من قيم الفهرس.

ولن يتمكن مشغل الفهرس الثاني من رؤية القيم التي قام مشغل الفهرس الأول بإدخالها.

"557-3xx...." "557-3*"
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إذا تطابقت القيمة التي قام مشغل الفهرس الثاني بإدخالها مع القيمة الأولى، لا حاجة إلى اتخاذ أي إجراء وتستمر 
عملية الفهرسة.

في حالة عدم تطابق القيمتين الأولى والثانية، يتم عرض مربع حوار دقة الإدخال ويتم تحديد الإدخال الصحيح 
بواسطة المشغل.

ملاحظات:

فهرس > إذا كان مشغل المسح الضوئي يقوم أيضًا بإدخال المجموعة الأولى من قيم الفهرس؛ فسيلزم تحديد •
 عند المسح الضوئي وإكمال عملية الفهرس الأول.2فهرس > فهرس متبوعًا على الفور بتحديد 1فهرس

 UPPER حساسة لحالة الأحرف. على سبيل المثال، لا تتطابق "2 وفهرس1تعتبر مقارنة قيمتي فهرس•
CASE" مع "Upper Case كما تعتبر الأصفار البادئة قيمة مميزة. على سبيل المثال، لا تتطابق القيمة ."

.0123 مع 123

يتم حذف المسافات البيضاء البادئة واللاحقة من حقول فهرس الإدخال المزدوج قبل حفظ القيمة. •

على سبيل المثال، في حالة إدخال القيمة "    شحنة     "، يتم حفظها كـ "شحنة". وهذا يعني إنه إذا تم إدخال 
 "شحنة     " تتطابق القيمتان.2 "     شحنة" وقيمة الفهرس1قيمة الفهرس

يتم عرض مربع حوار دقة الإدخال في حالة عدم تطابق قيمة الفهرس الثاني مع قيمة الفهرس الأول.دقة الإدخال

يتوفر لمشغل الفهرس الخيارات التالية:

.1إدخالتحديد الإدخال الذي قام به مشغل الفهرس الأول من خلال تحديد •

.2إدخالتحديد الإدخال الذي قام به من خلال تحديد •

 إذا لم يكن أي من الإدخالين صحيحًا.إدخال جديدإدخال قيمة جديدة في حقل •

إلغاء مربع حوار دقة الإدخال وإغلاقه إذا لم تكن هناك رغبة في الاختيار. إذا كان القرار هو ألاَّ يتم حل قيمة •
الفهرس غير المطابقة على حقل أو أكثر من حقول الفهرس المطلوبة؛ فستظهر الرسالة التالية عند محاولة 

يوجد حقل فهرس أو أكثر بحاجة إلى إدخال مزدوج. لا يمكنك إخراج المجموعة الآن. إخراج المجموعة، 
 هل تريد الدخول في وضع الفهرس؟

إذا لم يكن ملء حقول الإدخال المزدوج مطلوباً؛ فسيتم عرض مربع حوار دقة الإدخال عند الإخراج. يجب 
حلّ كل حقول فهرس الإدخال المزدوج التي تحتوي على إدخالات غير مطابقة قبل الإخراج.
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ملاحظات:

إذا لم يكن حقل الإدخال المزدوج مطلوباً، يمكن ترك إدخال أو أكثر من إدخالات الفهرس فارغة ولن يظهر •
مربع حوار دقة الإدخال ولن يحدث خطأ عند الإخراج.

إذا تم إدخال قيم الإدخال المزدوج ولم تكن متطابقة؛ فيجب على المشغل إجراء تحديد في مربع الحوار دقة •
الإدخال قبل الإخراج.

قد لا يتم استخدام حقل فهرس تم تمكينه للإدخال المزدوج لإجراء بحث في قاعدة البيانات أو أن يكون حقلاً تم •
التحقق منه أو ملؤه بواسطة البحث في قاعدة البيانات.

تحتوي قائمة التعليمات على الخيارات التالية:قائمة تعليمات

 عبر الإنترنت. اختصار Capture Pro — يسمح هذا الخيار بعرض المساعدة الخاصة ببرنامج المساعدة
.F1لوحة المفاتيح: 

— يعرض الدليل الذي يقدم الإجراءات البسيطة لاستخدام برنامج  Capture Proدليل بدء تشغيل برنامج 
Capture.وبدء التشغيل السريع 

— يعرض هذا الخيار مربع حوار إرسال تقرير عن خطأ، ويتيح لك إدخال رسالة إرسال تقرير عن الخطأ 
.Kodak Alarisتصف المشكلة وإرسالها إلى 

— يتيح لك هذا الخيار الوصول إلى مدير الترخيص حيث يمكنك الحصول بسهولة على مدير الترخيص 
 وغير متصلة بالإنترنت.Capture Proترخيص لمحطة عمل تستخدم برنامج 

.Capture Pro— يتيح لك تسجيل برنامج التسجيل 

 على Capture Pro — يعرض هذا الخيار تعليمات برنامج  على الإنترنتCapture Pro برنامج
الإنترنت.

 ، الذي يوفر Capture Pro — يعرض هذا الخيار مربع حوار حول برنامج Capture Proحول برنامج 
معلومات حول إصدار البرنامج الحالي. استخدم هذا المربع في عرض المعلومات التالية:

حقوق النشر•
امتداد الملف•
مسار الملف•
الرقم التسلسلي للبرنامج•
رقم إصدار البرنامج•

. توفر هذه النافذة نافذة معلومات الملفاتيتيح لك مربع الحوار هذا أيضًا الوصول إلى معلومات النظام الذي يفتح 
. إن نافذة معلومات الملفات للقراءة فقط.Capture Proمعلومات حول الملفات الفردية في برنامج 

اسم الملف•
حجم الملف•
تاريخ الإنشاء•
رقم الإصدار•
الوصف•

" في الزاوية اليمنى العلوية لإغلاق نافذة معلومات الملفات.Xانقر على "ملاحظة:
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الأدواتأشرطة

يحتوي شريط أدوات التقاط على الأوامر التالية:شريط أدوات التقاط

يحتوي شريط أدوات المجموعة على الأوامر التالية:شريط أدوات المجموعة

يحتوي شريط أدوات المستند على الأوامر التالية:شريط أدوات المستند

 — يسُتخدم هذا الخيار لبدء تشغيل المسح الضوئي للصور على الماسحة الضوئية.بدء

— يسُتخدم هذا الخيار لإيقاف المسح الضوئي للصور.إيقاف المسح الضوئي 

 — حدد اسم إعداد صفحة من القائمة المنسدلة بحيث يكون مناسبًا للمهمة التي يتم إجراء اسم إعداد الصفحة
مسح ضوئي لها.

، الذي يتيح لك إعداد مربع حوار إعداد الصفحة— يعرض هذا الخيار إعداد الصفحة 
معلمات المسح الضوئي.

 وجه واحد أو وجهان أو وجه واحد أمامي  — يتيح لك هذا الخيار تحديد الأوجه للالتقاط
.خلفي

ملاحظة: قد لا تتمكن من استخدام هذا الخيار مع بعض أجهزة المسح الضوئي التي ليست من 
. Kodakصنع 

، الذي يتيح لك مربع حوار المجموعة الجديدة — يعرض هذا الخيار المجموعة الجديدة
إنشاء مجموعة جديدة.

، الذي يتيح لك فتح مربع حوار مدير المجموعة يعرض هذا الخيار —فتح المجموعة 
.مجموعة موجودة

 — يتيح لك هذا الخيار إغلاق مجموعة مفتوحة حالياً.إغلاق المجموعة

 — يسُتخدم هذا الخيار لبدء إخراج كل الصور الموجودة في المجموعة إخراج المجموعة
الحالية.

.يتيح لك هذا الخيار إضافة مستند جديد — جديدمستند 

 — يتيح لك هذا الخيار إدراج صفحات إضافية في مستند تم مسحه ضوئياً. إدراج الصفحات
يترتب على تمييز الصورة الأولى تنشيط الأيقونة. ضع الصفحات الإضافية في الماسحة 

الضوئية، ثم انقر على الأيقونة.
— يسُتخدم هذا الخيار لتكرار المسح الضوئي لأجزاء محددة إعادة مسح الصفحات ضوئياً 

من المستند. قم بتمييز الصفحة أو الصفحات التي تريد إعادة إجراء المسح الضوئي لها، ثم 
ضع النسخ الأصلية في الماسحة الضوئية، ثم انقر على هذه الأيقونة.

— يتم تقسيم المستند إلى مستندين عند الصفحة المحددة. لتقسيم مستند ما، تقسيم المستند 
 (تقسيم المستند). في عارض الصور، انقر على الصفحة Split documentانقر على 

التي سيتم تقسيمها إلى مستند جديد. 
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يحتوي شريط أدوات العرض على الأوامر التالية:شريط أدوات العرض

يحتوي شريط أدوات التنقل على الأوامر التالية:شريط أدوات الانتقال

 — يعرض هذا الخيار أداة المؤشر التي تتيح لك تحديد الصور.أداة التحديد

.  وجه الصفحةأوصورة أو صفحة  — يسمح هذا الخيار بالتحديد من بين وضع الاختيار

 يمكنك النقر على إحدى الصور في عارض الصور الصورة،في حالة تحديد الخيار •
وسوف يتم تحديد الصورة على الفور.

، يمكنك النقر على الصورة والصفحة بالكامل وسيتم تحديد الوجه الصفحةفي حالة تحديد •
الأمامي والخلفي والأبيض والأسود والملون/بتدرج الرمادي.

إذا كنت تقوم بإجراء مسح ضوئي لعدة صور (مسح الدفع المزدوج الضوئي)، فعند تحديد •
، والنقر على صورة أمامية، سيتم تحديد جميع الصور الأمامية. إذا قمت وجه الصفحة

بالنقر على الوجه الخلفي للصورة، فيتم تحديد كل الأوجه الخلفية.

، يتم عرض أداة تكبير — يتيح لك هذا الخيار تكبير جزء من صورة. عند تحديد تكبير
التكبير. يمكنك تكبير أي منطقة يتم وضع أداة التكبير عليها. (يجب أن تنقر مطولاً على 

الصورة.)
 — يتيح لك تحريك الصورة حول النافذة عندما تكون الصورة أكبر من النافذة.تحريك

، أو 2، أو 1 — يتيح لك هذا الخيار استخدام السهم لأسفل لعرض عرض عارض الصور
، يتم عرض تخصيص التخطيط الخاص بك. عندما تقوم بتحديد تخصيصصور أو  8 أو، 4

 الذي يتيح لك إدخال عدد الصفوف والأعمدة التي مربع حوار إعداد التخطيط المخصص
.عارض الصورتريدها أن تظهر في 

.عارض الصور— يسُتخدم هذا الخيار في تكبير كل الصور الموجودة في تكبير 

— يسُتخدم هذا الخيار في تصغير كل الصور الموجودة في عارض الصور.تصغير 

 

 — يفتح شاشة البدء السريع، والتي توفر لوحات المهمة لتشغيل مهمة مسح البدء السريع
ضوئي.

.عارض الصور في المجموعة — يعرض هذا الخيار المستند الأول من المستند الأول

 — يعرض هذا الخيار المستند الأخير من المجموعة في عارض الصور.المستند الأخير

 — يعرض هذا الخيار المستند السابق من المجموعة في عارض الصور.المستند السابق

 — يعرض هذا الخيار المستند التالي من المجموعة في عارض الصور.المستند التالي
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يحتوي شريط أدوات وضع العلامة على الأوامر التالية:شريط أدوات وضع العلامة

يحتوي شريط أدوات التعديل على الأوامر التالية:شريط أدوات التحرير

 أو صورة. على سبيل صفحة— يتيح لك هذا الخيار وضع علامة على أداة وضع علامة 
المثال، قد ترغب في تحديد الصور التي ترغب في إعادة المسح الضوئي لها بشكل دائم.

 — يسُتخدم هذا الخيار في وضع علامة على كل الصور وضع علامة على كل المُحدد
.المجموعةالمحددة في 

— يتيح لك هذا الخيار وضع علامة على وضع علامة على ما الصور التي تم تصفيتها 
. عارض الصور المصغرّة أو عارض الصورالصور المعروضة حالياً في 

 — يسُتخدم هذا الخيار في إزالة أي صورة تم وضع علامة إلغاء وضع العلامة على الكل
عليها مسبقاً في المجموعة الحالية.

يوفر هذا الخيار إمكانية الوصول إلى حقول الفهرس على —  تعديل حقول الفهرس
.مستويات المجموعة والمستند

 درجة 90— يُستخدم هذا الخيار في تدوير الصورة (الصور) المحددة  درجة 90التدوير 
باتجاه عقارب الساعة.

 180— يسُتخدم هذا الخيار في تدوير الصورة (الصور) المحددة  درجة 180التدوير 
درجة باتجاه عقارب الساعة.

 270 — يسُتخدم هذا الخيار في تدوير الصورة (الصور) المحددة  درجة270التدوير 
درجة باتجاه عقارب الساعة.

— يتيح لك هذا الخيار تشغيل أداة مراقبة الجودة الذكية. سيتم توفير مراقبة الجودة الذكية 
جميع الصور المحددة للمراجعة والمعالجة. إذا لم يتم تحديد أية صور، فستتوفر جميع الصور 
التي تم وضع علامة عليها. كما يمكن تشغيل أداة مراقبة الجودة الذكية من خلال النقر بزر 
الماوس الأيمن على إحدى الصور الموجودة في عارض الصور أو مستكشف المجموعة، ثم 

تحديد مراقبة الجودة الذكية في قائمة التحديد.
 — يتيح لك هذا الخيار رسم مستطيل حول جزء من الصورة، ثم إزالة المنطقة رسم منطقة

 أو اقتصاص الصورة بحجم المستطيل باستخدام تفريغ؛داخل المستطيل باستخدام الخيار 
.اقتصاصالخيار 

 — يتيح لك هذا الخيار إزالة المنطقة خارج المستطيل الذي قمت بإنشائه باستخدام اقتصاص
خيار منطقة الرسم. 

 — يتيح لك هذا الخيار تفريغ المنطقة خارج المستطيل الذي قمت بإنشائه باستخدام تفريغ
خيار رسم منطقة. يتم عرض مربع تأكيد عند تحديد هذه الأيقونة. 

، الذي يتيح لك طباعة مستند  إعدادات الطباعةمربع حوارعرض هذا الخيار ي — طباعة
 داخل مستند.ةكامل أو صور محدد

، الذي يتيح لك PDFمربع حوار حفظ بتنسيق  — يعرض هذا الخيار PDFحفظ بتنسيق 
 يمكن البحث فيه أو لا يمكن البحث فيه.PDFحفظ مستند كامل أو صور فردية بتنسيق ملف 

 — يسُتخدم هذا الخيار في حذف صورة محددة أو أكثر في مستند. على حذف البحث المحدد
سبيل المثال، يمكن حذف الصور الفارغة من مستند ذي وجهين ويمكن ترقيم الصور المتبقية 

بعد حذف الصور المحددة. يتم عرض مربع تأكيد عند تحديد هذه الأيقونة.
 — يسُتخدم هذا الخيار في التراجع عن آخر عملية اقتصاص، أو تفريغ، أو تدوير تراجع

لصورة أو مجموعة من الصور. لا يمكن استخدام الخيار تراجع في التراجع عن أوامر 
الحذف.
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يحتوي شريط أدوات الفهرس على الأوامر التالية:شريط أدوات الفهرس

شريط أدوات عمليات ضبط الماسح 
الضوئي

يتيح لك شريط أدوات عمليات ضبط الماسحة الضوئية تغيير خيارات المسح الضوئي التالية من النافذة الرئيسية 
 مباشرة:Capture Proلبرنامج 

ملاحظات:

يتوفر شريط أدوات عمليات ضبط الماسحة الضوئية ويمكن استخدامه فقط مع أجهزة المسح الضوئي من •
Kodak.

تعتبر أية تغييرات في الإعدادات مؤقتة ولن يترتب عليها تعديل إعداد الصفحة الحالي المستخدم في المسح •
الضوئي.

عند تغيير أحد الإعدادات في شريط الأدوات، يتم تمييز الإعداد باللون الأصفر للإشارة إلى حدوث تغيير.•

عند تغيير إعداد الصفحة المستخدم في المسح الضوئي أو إذا تم تحديد إعداد الصفحة نفسه مرة أخرى، تتم •
إعادة تعيين إعدادات شريط أدوات عمليات ضبط الماسح الضوئي إلى القيم المحددة في إعداد الصفحة.

 يسُتخدم هذا الخيار في الانتقال إلى رقم المستند السابق الذي يحتوي على —السابق المستند
الصور.

— يسُتخدم هذا الخيار في الانتقال إلى رقم المستند السابق الذي يحتوي على المستند التالي 
الصور.

 — يسُتخدم هذا الخيار في الانتقال إلى رقم المستند التالي برقم فهرس غير الصالح التالي
غير صالح.

 — يسُتخدم هذا الخيار في تكبير عرض بيانات الفهرس الملتقطة مناطق التكبير/التصغير
للحقل الحالي مما يتيح لك رؤية واضحة للأحرف اللغوية الخاصة صعبة القراءة.

 — يتيح لك هذا الخيار سحب التعرّف الضوئي على الرموز من خلال السحب والإفلات
) من دون إدخال قيمة الفهرس. OCRالفهرس وإفلاته عبر التعرّف الضوئي على الرموز (

بعد تحديد الأداة، قم برسم مستطيل حول بيانات الفهرس المطلوب التقاطها.
تتيح لك هذه الأيقونة النقر على كلمة أو قيمة لتعيين حقل الفهرس المحدد. لإلحاق عدة كلمات 

 وانقر على الكلمات أو القيم الإضافية.Ctrlأو قيم، اضغط على مفتاح 

 — يتيح لك هذا الخيار تحديد لغة التعرّف الضوئي على لغة التعرّف الضوئي على الرموز
الرموز من القائمة المنسدلة. 

 — يسُتخدم هذا الخيار في حفظ التغييرات التي تم إجراؤها حفظ الفهرسة والخروج منها
 الحالية، ثم إغلاق نافذة الفهرس. المجموعةعلى 

 — يسُتخدم هذا الخيار في إغلاق نافذة الفهرس من دون حفظ إلغاء الفهرسة والخروج منها
أي تغييرات.

 يسُتخدم هذا الخيار في التحكم في إضاءة خلفية صورة وتعتيمها. القيم — الحد
.لخلفيةالأمامية و ا. يوجد إعداد حد منفصل للصور 255 إلى 0الصالحة من 

 — يسُتخدم هذا الخيار في تحسين الحواف الموجودة في مستند. كلما زاد التباين
 إلى 50 أو من -100 إلى 0مستوى التباين، زاد تحسين الحواف. القيم الصالحة من 

 حسب طراز جهاز الماسحة الضوئية الخاص بك. يوجد إعداد تباين منفصل 50
للصور الأمامية والخلفية.

iThresholding عند تحديد هذا الخيار تحدد الماسحة الضوئية إعداد الحد — 
الأمثل تلقائيًا لكل صفحة تم إجراء مسح ضوئي لها وبالتالي تحسين إنتاجية المسح 
الضوئي وجودة الصور الإجمالية. عند تحديد هذا الخيار، يبهت إعداد الحد للصور 

الأمامية والخلفية ولا يمكن تغييرها.

عودةالمقدمة

عودةالمقدمة
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 الخاصة بالمستند والمفتوحة حالياً في الصور و الصفحاتيعرض مستكشف المجموعة جميع المجلدات وملفات مستكشف المجموعة
 عند تنشيط التخطيط المحسّن.النافذة الرئيسية. وهو يظهر تلقائياً في الجانب الأيسر من عارض الصور

انقر على ملف صورة في مستكشف المجموعة ويتم عرض الصورة في عارض الصور.•

قم بسحب ملف صورة أو ملف صفحة أو مجلد مستند إلى موقع مختلف في مستكشف المجموعة.•

انقر بزر الماوس الأيمن على ملف صورة، أو ملف صفحة، أو مجلد مستند لعرض قائمة حساسة للسياق •
لمزيد من الخيارات.

 مع:Ctrlاضغط مفتاح •

 لتوسيع جميع العقد+

 لطي جميع العقد-

L لإنشاء مستند جديد يبدأ من الصفحة المحددة

X.لقص الصفحة أو الصورة المحددة 

Vللصق آخر صفحة أو صورة تم قصها قبل الصفحة أو الصورة المحددة 

 قبل يتم إدراج الصفحة ،Ctrl + V وكانت هناك صورة محددة عند تحديد صفحةإذا تم اقتصاص -
الصفحة التي تحتوي على الصفحة المحددة.

 قبليتم إدراج الصورة ، Ctrl + V وكانت هناك صورة محددة عند تحديد صورةإذا تم اقتصاص -
أول صفحة من الصفحات المحددة.
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 صور في نفس 8 أو 4 أو 2 أو 1عارض الصور هو المنطقة التي يتم فيها عرض الصور. يمكنك عرض عارض الصور
الوقت، أو تخصيص تخطيط عارض الصور.

 ورقم المستند للصور المعروضة في عارض الصور. المجموعةيحتوي شريط العنوان على اسم 

لنقل صورة:
حدد صورة..1
اسحب الصورة إلى الموقع المطلوب..2

لحذف صورة:
حدد صورة. .1
 (تعديل > حذف). سيتم حذف الصورة من المستند.Edit > Delete حدد.2

لتغيير عدد الصور المعروضة:
 (عرض > عرض عارض الصور).View > Image Viewer Displayحدد .1
. يعرض عارض الصور التخطيط المحدد. تخصيصأو 8 أو 4 أو 2 أو 1حدد .2

 يظهر مربع حوار إعداد التخطيط المخصص مما يتيح لك إدخال عدد تخصيص،عند تحديد ملاحظة:
الأعمدة والصفوف الذي ترغب في عرضه.

، تظهر قائمة تحتوي على الخيارات عارض الصورعندما تقوم بالنقر بزر الماوس الأيمن على صورة في قائمة حساسة للسياق للصورة
التالية:

 — تضع علامة على الصور كفارغة عند تحديد هذا الخيار إما من عارض الصور أو وضع علامة كفارغة
بالنقر بزر الماوس الأيمن على صورة محددة. متوفر فقط عند تمكين خيار "الاحتفاظ بالصور الفارغة" ضمن 

"الحذف التلقائي" في إعداد الصفحة المحددة حالياً. عند تحديد صورة، يتم تمييز الصورة في عارض الصور بحد 
أزرق داكن غامق.

.  وجه الصفحةأوصورة أو صفحة  — حدد وضع التحديد

 يمكنك النقر على إحدى الصور في عارض الصور وسوف يتم تحديد الصورة،في حالة تحديد الخيار •
الصورة على الفور.

، يمكنك النقر على الصورة والصفحة بالكامل وسيتم تحديد الوجه الأمامي والخلفي الصفحةفي حالة تحديد •
والأبيض والأسود والملون/بتدرج الرمادي.

، وجه الصفحةإذا كنت تقوم بإجراء مسح ضوئي لعدة صور (مسح الدفع المزدوج الضوئي)، فعند تحديد •
والنقر على صورة أمامية، سيتم تحديد جميع الصور الأمامية. إذا قمت بالنقر على الوجه الخلفي للصورة، 

فيتم تحديد كل الأوجه الخلفية.

 — يلُغي تحديد الصور المميزة في عارض الصور.إلغاء تحديد الكل

 — يحذف الصور المميزة بعد تأكيد المستخدم.حذف

— يُستخدم هذا الخيار في نسخ صورة محددة من أجل لصقها في موقع آخر.نسخ 

 من أجل إنشاء منطقة في الصورة، يتيح لك هذا الخيار رسم منطقة— بعد استخدام خيار نسخ منطقة الصورة 
نسخ هذه المنطقة إلى موقع آخر.

 الذي يتيح لك مربع حوار نسخ الصورة إلى إعداد المهمة — يعرض هذا الخيار نسخ الصورة إلى إعداد المهمة
 من أجل إنشاء رمز نافذة التعرّف الضوئي على الرموز  أو نافذة الأيقونة الشريطي،استيراد الصور في 

شريطي، أو مناطق تعرّف ضوئي على الرموز.

 درجة باتجاه عقارب الساعة.270 أو 180 أو 90 — يسُتخدم هذا الخيار لتدوير صورة محددة بزاوية تدوير

— يتيح لك هذا الخيار تشغيل أداة مراقبة الجودة الذكية. سيتم توفير جميع الصور المحددة مراقبة الجودة الذكية 
للمراجعة والمعالجة. إذا لم يتم تحديد أي صورة؛ فستتوفر جميع الصور التي تم وضع علامة عليها.

— يسُتخدم هذا الخيار في فصل المستند المحدد يدوياً، مما يؤدي إلى تقسيم المستند المحدد إلى تقسيم المستند 
مستندين.

 — يسُتخدم هذا الخيار في إرفاق المستند المحدد بالمستند السابق من أجل إنشاء مستند واحد.دمج إلى السابق

 — يتيح لك هذا الخيار زيادة حجم الصور المعروضة أو تصغيره. تكبير/تصغير
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عارض يستخدم هذا الخيار في ملاءمة كل صورة مع الجزء الخاص بها في  :ملاءمة الصور مع النافذة•
، بغض النظر عن حجمها الأصلي.الصور

: يسُتخدم هذا الخيار في تكبير صور إلى حجمها الفعلي.فعلي•

: يسُتخدم هذا الخيار في تكبير صورة بمقدار نسبة ثابتة حسب إعداد درجات التكبير/التصغير.تكبير•

: يسُتخدم هذا الخيار في تصغير صورة بمقدار نسبة ثابتة حسب إعداد درجات التكبير/التصغير.تصغير•

 التي تتيح مربع حوار درجات التكبير/التصغير: يسُتخدم هذا الخيار في الوصول إلى درجات التكبير/التصغير•
.5 بمقدار زيادة %40 إلى %15لك تحديد نسبة من 

 أو أعلى أوأسفل أواليسار أواليمين— يتيح لك هذا الخيار تحريك كل الصور إلى تحريك جميع الصور إلى 
.الموقع نفسه

، الذي يتيح لك تغيير إعدادات مربع حوار إعداد درجات التحريك — يعرض هذا الخيار إعداد درجات التحريك
البيكسل لأداة التحريك.

 المجموعة. — يسُتخدم هذا الخيار في إخفاء كل الصور الأمامية في إخفاء الوجه الأمامي

 — يسُتخدم هذا الخيار في إخفاء كل الصور الخلفية في المجموعة.إخفاء الوجه الخلفي

 — يسُتخدم هذا الخيار في إخفاء كل الصور بالأبيض والأسود الموجودة في المجموعة.إخفاء الأبيض والأسود

 — يُستخدم هذا الخيار في إخفاء كل الصور بالتدرج الرمادي في المجموعة.إخفاء تدرج الرمادي

 — يسُتخدم في إخفاء كل الصور في المجموعة.إخفاء اللون

 قبل النقر بزر الماوس الأيمن على صورة؛ فستظهر  رسم منطقةأووضع العلامة أو التكبير إذا قمت بتحديد أداة 
خيارات إضافية في القائمة.

إذا كانت أداة وضع العلامة نشطة، فسيتم عرض خيارات وضع العلامة. •

— يسُتخدم هذا الخيار في وضع علامات تحديد على كل الصور المحددة وضع علامة على كل المُحدد -
 أثناء النقر على الصور الموجودة Controlفي المجموعة. لتحديد أكثر من صورة واحدة، اضغط مفتاح 

في عارض الصور.

 — يسُتخدم هذا الخيار في وضع علامات تحديد على كل الصور المحددة في وضع علامة على الكل -
المجموعة.

 — يسُتخدم هذا الخيار في إزالة علامات التحديد الخضراء عن كل الصور إلغاء وضع علامة على الكل-
الموجودة في المجموعة.

— يسُتخدم هذا الخيار في تحديد كل الصور (المعروضة) وضع علامة على الصور التي تم تصفيتها -
التي تم تصفيتها، ثم وضع علامات تحديد خضراء عليها.

مربع حوار إعداد  نشطة، يتم عرض خيار نسبة التكبير. يسُتخدم هذا الخيار في عرض التكبيرإذا كانت أداة •
 الذي يتيح لك تحديد حجم الصورة المعروضة عند استخدام أداة التكبير.نسبة التكبير

 نشطة، يتم عرض الخيارات المرتبطة بهذه الأداة. رسم منطقةإذا كانت أداة •

 — يسُتخدم هذا الخيار في تطبيق المنطقة المحددة على كل الصور تطبيق المنطقة على المستند-
الموجودة في المستند.

 — يسُتخدم هذا الخيار في تطبيق المنطقة المحددة على الصور المحددة فقط.تطبيق المنطقة على المحدد-

 — يتيح لك هذا الخيار إزالة المنطقة خارج المستطيل الذي قمت بإنشائه باستخدام خيار منطقة اقتصاص-
الرسم. يتم عرض مربع تأكيد عند تحديد هذا الخيار.

 — يتيح لك هذا الخيار تفريغ المنطقة خارج المستطيل الذي قمت بإنشائه باستخدام خيار رسم تفريغ-
منطقة. يتم عرض مربع تأكيد عند تحديد هذا الخيار.
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 المفتوحة حالياً.المجموعةيوفر عارض الصور المصغرّة إصدارات صور مصغرّة من كل الصور الموجودة في عارض الصور المصغرّة

لتحديد صورة في عارض الصور:

 المصغرّة.عارض الصور انقر على صورة مصغرّة في•

لتكبير صورة مصغرّة:

انقر بزر الماوس الأيسر مطولاً على الصورة. يمكنك تحريك المنطقة المكبّرة من خلال متابعة النقر •
المستمر.

القائمة الحساسة للسياق في عارض 
الصور المصغرّة

 سوف تظهر خيارات القائمة التالية:المصغرّة،عندما تقوم بالنقر بزر الماوس الأيمن على إحدى الصور 

— يسُتخدم في إخفاء كل الصور المصغرّة الأمامية والخلفية.  الوجه الخلفي أوالوجه الأمامي 

— يسُتخدم في إخفاء كل الصورة المصغرّة ذات اللون الأبيض  ألوان أوأبيض وأسود، أو تدرج رمادي 
والأسود، وتدرج الرمادي، والألوان.

 مما يتيح لك تغيير حجم مربع حوار إعداد حجم الصورة المصغرّةيتم عرض حجم الصورة المصغّرة — 
الصورة.

يترتب على تحديد أداة مراقبة الجودة الذكية في شريط أدوات التعديل تشغيل أداة مراقبة الجودة الذكية. سيتم أداة مراقبة الجودة الذكية
توفير جميع الصور المحددة للمراجعة والمعالجة. إذا لم يتم تحديد أية صور، فستتوفر جميع الصور التي تم 

وضع علامة عليها. كما يمكن تشغيل أداة مراقبة الجودة الذكية من خلال النقر بزر الماوس الأيمن على الصورة 
الموجودة في عارض الصور أو مستكشف المجموعة، ثم تحديد مراقبة الجودة الذكية في قائمة التحديد.

لا تتوفر أداة مراقبة الجودة الذكية أثناء إجراء المسح الضوئي أو إعادته أو إذا كانت وظيفة الاستيراد ملاحظة:
التلقائي تراقب المجلد الفعال لملفات الصور بنشاط.

عند تحديد أداة مراقبة الجودة الذكية، يتم عرض الصورة الأولى في لوحة الصور اليسرى. وتعرض لوحة 
الصور اليسرى شكل الصور من دون إجراءات المعالجة الإضافية. تعرض لوحة الصور اليمنى شكل الصورة 

بعد تنفيذ المعالجة.

يمكنك تعديل الصورة من خلال النقر على واحدة أو أكثر من أدوات معالجة الصور الموجودة بين لوحات 
الصور. للتراجع عن وظيفة معالجة صور، انقر على الأداة مرة أخرى لإلغاء تحديدها.
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 — عند تحديد هذا الخيار، يتم استخدام أدوات معالجة الصور المحددة تطبيق الإعدادات على الصورة التالية
 وكانت الصورة التالية أبيض تثنيةحالياً وتطبيق إعدادات الأداة على الصورة التالية عند اللزوم. في حالة تحديد 

 أيضًا، سيتم تطبيقه على الصورة الأبيض والأسود.ملء الفراغوأسود، فلن تتم تثنية الصورة. لكن إذا تم تمكين 

 الصور المحددة باستخدام كل— يقوم هذا الخيار بتطبيق أدوات معالجة الصور المحددة على تطبيق على الكل 
أداة مراقبة الجودة.

 حفظ التالي — يظهر هذا الخيار إذا كانت الصور الإضافية متاحة للمراجعة. يترتب على النقر على التالي
تطبيق على التالي الصورة الحالية كما هي معروضة في لوحة الصور المعالَجة. في حالة تحديد مربع الاختيار 

سيتم تطبيق أدوات معالجة الصور المحددة على الصورة التالية. سيتم عرض الصورة قبل المعالجة في لوحة 
. المعالجة بينما سيتم عرض الصور التي تمت معالجتها في لوحة الصور الأصلية،الصور 

 — يعرض هذا الخيار الصورة التي سبق عرضها. سيتم تعطيل كل تحديدات الأدوات وسيتم إلغاء تحديد رجوع
 (التالي).Next. يتم عرض الصورة كما كانت عند تحديد زر تطبيق على التاليخانة الاختيار 

 — في حالة وجود صور بتدرج الرمادي/الألوان عرض أبيض وأسود (عرض تدرج الرمادي / الألوان)
وصورة أبيض وأسود مرتبطة بها (التدفق المزدوج)، يتم عرض الصورة بالأبيض والأسود في لوحة الصور 

.عرض تدرج الرمادي/ألوان. لعرض صورة بتدرج الرمادي/الألوان، انقر على زر الأصلية

 بيانات الفهرس لكل مجموعة عارض الصورللتسهيل، تعرض نافذة الفهرس الموجودة في الجانب الأيمن من نافذة الفهرس
ومستند تم تحديد فهارس له. وهي متوفرة كعلامة تبويب قابلة للسحب في الجانب الأيمن من الشاشة. يمكن 

عرض بيانات الفهرس لفترة وجيزة (مرر الماوس وأوقفه على علامة التبويب) أو تثبيتها اختيارياً على عرض 
 Captureالصورة لعرض حقول الفهرس لكافة الصور الخاصة بك مطولاً أثناء مسحها ضوئياً في برنامج 

Pro يمكنك استخدام هذه الميزة لعرض حقول الفهرس لمستند معين أو للمجموعة بأكملها. لإجراء أي .
تعديل حقول تصحيحات ضرورية لمحتوى كل حقل فهرس، يجب أن تنتقل إلى وضع الفهرسة من خلال تحديد 

  من قائمة الفهرس.الفهرس

لفتح نافذة الفهرس:

انقر على علامة تبويب نافذة الفهرس الموجودة على يسار عارض الصور. لمنع إغلاق النافذة، انقر على •
 الموجودة في الزاوية اليمنى العلوية من النافذة مرة واحدة.التثبيتأيقونة 

لإغلاق نافذة الفهرس:

 أو انقر على أي مكان خارج نافذة الفهرس. إذا كانت النافذة مفتوحة المسمارانقر نقرًا مزدوجًا على أيقونة •
 مرة واحدة لإغلاقها.التثبيتومثبتة؛ فانقر على أيقونة 
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 المفتوحة المجموعة إحصائيات حول عارض الصورتعرض نافذة المعلومات الموجودة في الجانب الأيمن من نافذة المعلومات
حالياً. يمكنك تثبيت فتح نافذة المعلومات لعرض إحصائيات المجموعة مطولاً أثناء مسح الصور ضوئياً إلى 

.Capture Proبرنامج 

يمكن عرض المعلومات في هذه النافذة للمجموعة أو لكل مستند أو لكل صفحة أو لكل صورة. تشمل معلومات 
الصورة رقم تسلسل الصورة ومعرّف الصورة، والموقع على القرص، والضغط، والدقة، وحجم الصورة، 

وسلسلة الطباعة.

لفتح نافذة المعلومات:
، أو ميِّز صورة من عارض الصور.مستكشف المجموعة، أو صفحة أو مستند من صورةميِّز .1

انقر على علامة تبويب نافذة المعلومات الموجودة على يمين عارض الصور. لمنع إغلاق النافذة، انقر على .2
 الموجودة في الزاوية اليمنى العلوية من النافذة مرة واحدة.التثبيتأيقونة 

لإغلاق نافذة المعلومات:
 أو انقر على أي مكان خارج نافذة المعلومات. إذا كانت النافذة مفتوحة التثبيتانقر نقرًا مزدوجًا على أيقونة •

 مرة واحدة لإغلاقها.التثبيتومثبتة؛ فانقر على أيقونة 
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 معلومات حول المجموعات التي تقوم بالتحضير للإخراج من Capture Proتوفر نافذة حالة معالجة مجموعة نافذة حالة معالجة المجموعة
.Capture Proبرنامج 

لعرض قائمة التحكم: التحكم انقر على

 وعرض سجل الإخراج.Notepad— يسُتخدم هذا الخيار في فتح نافذة عرض السجل •

 — يسُتخدم هذا الخيار في حذف كل الإدخالات الموجودة في سجل الإخراج. يتم عرض مربع مسح السجل•
تأكيد للتحقق من الاختيار.

، الذي يحتوي على أمر لعرض كافة Capture Proمربع حوار حول برنامج  — يتيح هذا الخيار فتح حول•
.Capture Proالملفات في برنامج 

، الذي يحتوي على أوامر للخروج مربع حوار خيارات إيقاف التشغيليسُتخدم هذا الخيار في فتح خروج — •
 بشكل Capture Pro. تتم معالجة الإخراج في الخلفية ويتم تنفيذ برنامج Capture Proمن برنامج 

، سيطلب منك متابعة معالجة الإخراج أو إيقافها.Capture Proمستقل. إذا قمت بإغلاق برنامج 

 المعلومات التالية حول كل مجموعة قد تم Capture Proتوفر نافذة حالة معالجة المجموعة الخاصة ببرنامج 
اسم المهمة، واسم المجموعة، ووقت الإرسال، والحالة، واسم المستخدم، والتقدم، إخراجها أو يتم إخراجها: 

.الوصفو

مسح الأخطاء  أو لمسح كافة الأخطاءانقر بزر الماوس الأيمن على إدخال اسم المجموعة على الشبكة •
.المحددة

لعرض نافذة حالة معالجة المجموعة:

 (المجموعة > عرض حالة إخراج المجموعة).Batch > View Batch Output Statusحدد •

 معلومات حول المجموعة الحالية، والمستند الحالي، ومساحة القرص Capture Proيوفر شريط حالة برنامج شريط الحالة
المتوفرة، وإذا كانت عوامل تصفية عرض الصور قيد التشغيل أو تم إيقاف تشغيلها. يقع شريط الحالة أسفل 

من قائمة عرض أو باستخدام شريط الحالة الشاشة ويمكن إظهاره أو إخفاؤه من خلال تحديد/إلغاء تحديد 
.Ctrl + Sالاختصار 

يعرض شريط الحالة مساحة القرص المتوفرة بالميجابايت، وعدد المستندات، والصفحات، والصور في 
المجموعة المفتوحة الحالية، وعدد الصور في المستند المعروض حالياً في نافذة عارض الصور وحالة منقيات 

الصور.

؛ فهذا يشير إلى أن أنواع الصور مثل "الصور الخلفية" أو "الصور بتدرج قيد التشغيلإذا كان منقي الصور 
عرض > منقي عارض الصور.الرمادي" لا تظهر كعناصر قائمة محددة 
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أثناء إجراء المسح الضوئي للصفحات، تظهر الصور في كل العارضات المعروضة: عارض الصور و/أو تغيير وجهة النافذة الرئيسية
 تخطيطي شاشة Capture Proعارض الصور المصغرّة و/أو مستكشف المجموعة. يتوفر في برنامج 

. مُحس̒ن و كلاسيكيافتراضيين: 

 تخصيص تخطيط النافذة الرئيسية عن طريق نقل أشرطة الأدوات Capture Proيتيح لك برنامج 
والعارضات، وما إلى ذلك، بما يتناسب مع تفضيلاتك الخاصة وإخفاء أي مكونات غير مرغوب فيها على 

الشاشة.

 نافذة المعلومات وعارض الصور المصغرّة ومستكشف المجموعة وعارض الصورتسري هذه الخيارات على 
. تقع هذه الأيقونات في الزاوية اليمنى العلوية من هذه النوافذ:نافذة الفهرسو

ويمكنك ضبط حجم الصور في العارضات كما هو مطلوب. يمكن ضبط عارض الصور على حجم ثابت أو يبقى 
الافتراضي والذي يعرض الصور بأفضل حجم بالنسبة للشاشة. أفضل ملاءمة على خيار 

 إعدادات Capture Proيمكن تحريك أشرطة الأدوات نوافذ الصور أو إخفاؤها حسب الرغبة. يحفظ برنامج 
كل مهمة عند إنهائها. وهذا يعني أنه يمكن عرض المهام المختلفة بالطريقة التي تريدها لكل مهمة. يمكنك في أي 

) وإعادة تعيين الشاشة إلى التخطيط الافتراضي.محسّن (أو عرض > تخطيط > كلاسيكيوقت تحديد 

إذا كنت تستخدم التخطيط الكلاسيكي وتريد إضافة نافذة من التخطيط المحسّن، قم بعرض قائمة عرض وتحديد 
نافذة (على سبيل المثال، مستكشف المجموعة ونافذة الفهرس). يتم عرض النافذة الإضافية في التخطيط 

الكلاسيكي.

لإغلاق أي نافذة. لفتح النافذة مرة أخرى، حدد النافذة التي تريد عرضها من قائمة عرض.

لتثبيت نافذة مفتوحة. لإخفاء النافذة تلقائياً، انقر على أيقونة المسمار.

يسُتخدم في إخفاء النافذة تلقائياً مع ترك شريط العنوان فقط مفتوح. لإظهار النافذة، قم 
بتحريك المؤشر على شريط العنوان.

 (تظهر في شكل أربع نقاط رأسية) تقع في الزاوية اليمنى العلوية من نقطة التثبيت أيقونات
النوافذ. عندما تقوم بتحديد أيقونة نقطة تثبيت وتضغط زر الماوس مطولاً، يتم تحرير نقطة 
تثبيت الصورة وتظهر أسهم موقع زرقاء. وأثناء الضغط على زر الماوس، يمكنك تحريك 
النافذة إلى موقع جديد. عندما تكون النافذة في الموقع الذي تريده، قم بتحرير زر الماوس.



A-61992_ar 202245  مارس

 أو 4. أو 2 أو 1— يظهر عارض الصور فقط. يمكن اختيار عدد الصور المعروضة من تخطيط كلاسيكي •
 صفوف.6 أعمدة و6 أو يمكن تخصيص حتى 8

يظهر عارض الصور وعارض الصور المصغرّة ومستكشف المجموعة. يمكن تغيير  —تخطيط محسَّن •
حجم كل نافذة حسب الطلب.
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استكشاف الأخطاء وإصلاحها   3

 على Kodak Alaris على موقع ويب Capture Proيمكن العثور على دعم برنامج الدعم الفني
www.alarisworld.com/go/CaptureProSupport توفر صفحات الدعم معلومات حسب المنتج؛ .

مثل الوصول إلى التنزيلات الخاصة بترقية المنتج، وبرامج التشغيل، والملحقات، والوصول إلى الأسئلة الشائعة 
 في بلدك/منطقتك.Capture Proوتفاصيل خيارات الدعم المتوفرة لبرنامج 

 

www.kodakalaris.com/go/CaptureProSupport
www.kodakalaris.com/go/CaptureProSupport
www.kodakalaris.com/go/CaptureProSupport
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الملحق أ   اختصارات لوحة المفاتيح

، تتوفر الاختصارات التالية:Capture Proتبعاً لمكان عملك في برنامج 

•F1 متوفر في أيّ مكان في برنامج -مساعدة Capture Pro.

 هذه الاختصارات متوفرة:مستكشف المجموعة / عارض الصور:•
عام

Jإعداد المهمة
F2إظهار قائمة إعداد الصفحة
F5إظهار إعداد الصفحة
F3فتح المجموعة
F7بدء الالتقاط
F6إيقاف الالتقاط

التقاط مستند جديدإدخال
Ctrl-Enterالتقاط مستند جديد

Oإخراج المجموعة
Ctrl+Shift-Wإغلاق المجموعة

Ctrl+Sإظهار/إخفاء شريط الحالة
Ctrl+Pطباعة

عرض وتعديل
Aعرض حجم الصورة الفعلي
Fملاءمة الصورة للنافذة

ضبط رقم الصفحات للعرض في عارض الصور8، أو 4، أو 2، أو 1
Ctrl-F9 إظهار/إخفاء الصور الملونة
Ctrl-F10 إظهار/إخفاء صور تدرج الرمادي
Ctrl-F11 إظهار/إخفاء صور الأسود والأبيض
Ctrl-A(مستكشف المجموعة) تحديد كل الصور
Ctrl-D(مستكشف المجموعة) إلغاء تحديد كل الصور
Ctrl-F(مستكشف المجموعة) تحديد كل الصور ذات العلامات

F4(مستند محدد) إرفاق صفحة
Insertإدخال صفحات في صفحة محددة
Delحذف مستند محدد أو صفحات محددة
F8حذف مستند محدد
Cتحديد أداة وضع العلامات
Mتحديد أداة التكبير
Pتحديد أداة التحريك
Sتحديد أداة المحدد
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)يتُبععرض وتعديل (

تحريك لأعلى

تحريك لليمين

تحريك لأسفل

تحريك لليسار

Shft- 180تدوير°

Shft- 90تدوير°

Shft- 180تدوير°

Shft- 270تدوير°

تكبير+
تصغير-

Ctrl+L(مستكشف المجموعة) تقسيم مستند
Kإعداد إزالة الصور الفارغة
Rًإعادة مسح الصورة (الصور) المحددة ضوئيا
Zتحديد أداة رسم منطقة

Ctrl-Bمنطقة محددة خالية
Ctrl-Rقص منطقة محددة
Ctrl-Zتراجع عن التفريغ أو القص الأخير
Ctrl-Iنسخ منطقة الصورة

التنقل
D...انتقل إلى رقم المستند
I...انتقل إلى رقم الصورة

مستكشف المجموعة
Ctrl-Homeأول مستند في المجموعة
Ctrl-Endآخر مستند في المجموعة

Ctrl-Page Upالمستند السابق من المجموعة
Ctrl-Page Downالمستند التالي في المجموعة

عارض الصور
الصفحة الأولى في المستندالصفحة الرئيسية

Endالصفحة الأخيرة في المستند
Page Upالصفحات السابقة - كل المستندات

Page Downالصفحات التالية - كل المستندات
 هذه الاختصارات متوفرة:وضع الفهرسة:•

Eتعديل حقول الفهرس
F9المستند السابق
F10المستند التالي
F11المستند غير الصالح التالي
F12حفظ والخروج من الفهرسة
Escإلغاء والخروج من الفهرسة
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